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Installation 

Installation 

Before installation, please make sure all firmware (GW firmware, Smart Operation Panel firmware, and 
Smart Operation Panel applications) are the latest version. Regarding the firmware update procedures, 
please refer to the device service manual. 

Installation (Smart Operation Panel/WVGA/4.3-inch operation panel models) 

 Depending on the device model, the actual operation panel screen may look different from the 
screenshots used in this document. 

 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

1. Network information 
* Setting from System Settings of the device 
* In the case of Smart Operation Panel models, [User Tools] must be selected first and then the [User 
Tools / Counter / Enquiry] screen is displayed. 

 

The device network environment 

settings 

The VM Card Installation/JavaVM 

Configuration 

The Reader/writer connection for 

the IC Card 

The Installation environment setting 

Installation 1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 

Priority feature setting  

(Only for Standard Operation Panel 

models) 

Smart Operation Panel model 

specific settings  

(Only for Smart Operation Panel 

models) 
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Item Detailed descriptions Default/Remarks 

Host 
Name 

Set the host name shown on [Interface Settings] tab. 
This setting is performed on the screen keyboard. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

IP 
Address/ 
Subnet 
Mask 

Set the IP address and the subnet mask that appear when 
[Machine IPv4 Address] in [Interface settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
addresses with the 10-key. 

 

- 
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Item Detailed descriptions Default/Remarks 

Default 
Gateway 

Set the address that appears when [IPv4 Gateway Address] in 
[Interface Settings] tab is selected. 
For setting, enter the address with the 10-key. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

DNS 
Server 
1/DNS 
Server 
2/DNS 
Server 
3 

Set the server address that appears when [DNS Configuration] 
in [Interface Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
address with the 10-key. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

Domain 
Name 

Set the name that appears when [Domain Name] in [Interface 
Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
name with the screen keyboard. 

 

 

- 

 
2) Timer Setting 
* Setting in [Timer Settings] of [System Settings] 

 

Item Detailed descriptions Default/Remarks 

Auto 
Logout 
Timer 

The default value is [Off], however press [Auto Logout Timer] in 
[Timer Settings] tab and select [On] to enter the log out time if 
necessary to change it. 
The range of entering the automatic logout time is from 60 to 
999 seconds. 

Default: [Off] 
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Installation of VM Card 

 
 If the JavaVM is installed to the device’s Flash Memory (FM), this procedure is not 

necessary. In this case, please proceed to the “JavaVM Configuration”. 
 If JavaVM is not installed to the device, this procedure is not necessary. In this case, 

please proceed to the “IC Card Reader/Writer Connection (NFC R/W)”. 

1. Set [Auto Off timer] to 5 minutes in [User Tools / Counter / Enquiry] screen  [System Settings]  
[Timer Settings] tab. 

 
 [Auto Off Timer] at the device side should be set to 5 minutes to prevent the device from 

entering the Auto Off mode while the Java TM Platform is installing or activating. 

2. Set [System Auto Reset Timer] to [Off] in [User Tools / Counter / Enquiry] screen  [System 

Settings]  [Timer Settings] tab. 

 
 This setting should be restored after the installation. 

3. Turn off the main power of the device. 
4. Insert the VM card into the SD card slot. 

 
 For which the SD card slot should be inserted into, see the service manual of each 

machine. 
5. Turn on the main power of the device. 

 
 The Java TM Platform is installed automatically if the main power of the device is turned on 

after the VM card insertion. 
 It takes for approx. from 3 to 4 minutes to install it automatically. 
 Never turn off the power of the device during the installation, otherwise it may damage the 

VM card. Turn off the power after the confirmation in step 8 has been done. 
6. Press [User Tools/Counter] button. 
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7. Press [Extended Feature Settings] after [User Tools / Counter / Enquiry] screen appears. 

 
8. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears after the 

installation is completed normally. 
 

JavaVM Configuration 

1. Press [User Tools/Counter] button. 
2. Press [Extended Feature Settings] after [User Tools / Counter / Enquiry] screen appears. 
3. Press [Extended Feature Settings]. 
4. Press [Administrator Tools] tab, and then press [Heap / Stack Size Settings]. 

 
5. Set the heap size and stack size.  

Model Heap size  Stack size 
11S or earlier 16MB (Default: 10MB) 64KB (Default: 64KB) 
11A or later 48MB (Default: 16MB) Do not change from default size (Default: 256KB) 

6. Press the [Administrator Tools] tab, and then press [Select Available Functions]. 
  



 Technical Bulletin PAGE: 11/48 

Reissued: 26-Dec-18 

Model: Card Authentication Package v2 Date: 12-Mar-12 No.: RD602007l 
 

 

7. Set [PanelService API] as [Active]. 

 
8. Finish [User Tools]. 
9. Push the power button at the side of operation section, and turn off the main power after the power 

indicator has finished blinking. 

 
 The VM card should be operated with setting in the SD card slot. 
 Restore the original setting after installation if the change of [System Auto Reset Timer] is 

performed. 

IC Card Reader/Writer connection 

 
 The Installation should be executed after the main power is turned off. 

Connect the IC card Reader/Writer to the device. 

 
 Connect the USB cable to the left USB port for Aficio MP C5000/C4000/C3300/C2800, Aficio 

MP C2550/2050. 
 For other machines, either port can be connectable. 
 Regarding NFC Card Reader installation, please refer to the service manual for each model.  
 With Smart Operation Panel models, connect to the USB port of the device as with Standard 

Operation Panel models. 
 If your customer uses a NFC card reader, please refer to “IC Card Reader/Writer Connection 

(NFC R/W)” section for how to connect. 
 

IC Card Reader/Writer connection (NFC R/W) 

 
NFC R/W can be used with 15S or later Smart Operation Panel models. 

1. Remove the cover at the right side of the Panel. 
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2. Connect a NFC R/W to the micro USB port. 

 

Authentication Management Settings 

1. Log in the device as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

 
2. Press [User Tools/Counter] button, and then press [System Settings]. 

 
3. Press [Administrator Tools] tab, and set items below: 

[Administrator Authentication Management] 
[User Authentication Management] 
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1) Administrator Authentication Management 
[User management] 

 
1. Set [Admin. Authentication] to [On]. 
2. Press [Administrator Tools] of [Available Settings]. 
3. Press [OK] of the upper right, and enable the change. 
[Machine Management] 

 
1. Set [Admin. Authentication] to [On]. 
2. For setting all items in [Available Settings] to values, press [General Features], [Tray Paper 

Settings], [Timer Settings], [Interface Settings], [File Transfer], [Administrator Tools] and 
[Maintenance]. 

3. Press [OK] of the upper right, and enable the change. 
 
[Network Management] 
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1. Set [Admin. Authentication] to [On]. 
2. For setting all items in [Available Settings] to values, press [Interface Setting], [File Transfer], and 

[Administrator Tools]. 
3. Press [OK] of the upper right, and enable the change. 
 
[File Management] 

 
1. Set [Admin. Authentication] to [On]. 
2. Press [Administrator Tools] of [Available Settings]. 
3. Press [OK] of the upper right, and enable the change. 
 
2) User Authentication Management 
1. Confirm whether the method of the authentication is “Custom” or “LDAP”. 

* The displayed authentication type changes depending on a model. 

 
2. Set [Printer Job Authentication] to [Entire].  
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3. Set [Available Functions: Copier] to [None]. 

 
4. Set [Available Functions: Printer] to [None]. 
5. Reset [Document Server], [Facsimile], [Scanner] and [JavaTM/X] in [Available Functions: Other 

Functions]. 
6. Press [OK] of the upper right, and enable the change. 
Turn the power off and on after the settings of [Administrator Authentication Management] and [User 
Authentication Management] are finished. 
 
With 15S or later Smart Operation Panel models, cancel the all items beside [Available Functions] (Do 
not follow Step 3-6 above). 

 
 
 

Installation of Card Authentication Package v2 

Install the following applications using Remote Install Manager to install Card Authentication Package 
v2. For the installations procedures of these applications, see the service manual of Remote Install 

Manager. (  Remote Install Manager) 
 

 
 In the case of Smart Operation Panel models (Hybrid mode), it is necessary to install 3 

modules for CAP before activation when conducting offline installation:  
 CAP V2 Z11 
 CAP User Config.*1 
 CAP NFC Plug-in *2 



 Technical Bulletin PAGE: 16/48 

Reissued: 26-Dec-18 

Model: Card Authentication Package v2 Date: 12-Mar-12 No.: RD602007l 
 

 

*1 The CAP User Config. Tool is used only when the authentication type is Local DB or 
CAP-ES (Internal user). If the authentication type is AD, LDAP, or CAP-ES (only external 
user), it is not necessary to install the module for CAP User Config. Tool. 
*2 CAP NFC Plug-in is used for the card authentication between a NFC card reader and 
15S or later Smart Operation Panel models.    

 If installing CAP (F12) (Full Native mode), “Remote Install Manager v1.7.4” or later version 
is required. 

 
In the case of Standard Operation Panel and Smart Operation Panel (Compatibility mode): 

Application Version Note 

CAP V2 
MP11/MP21/MP31/SP31 

V2.x 

MP11 (WVGA models) 
MP21 (4-line LCD LP models) 
MP31 (12A or older 4.3-inch operation panel MFP models) 
SP31 (12S or later 4.3-inch operation panel LP models) 

CAP LAUNCHER V2.x  

CAP V2.x  

CAP REG V2.x  

 
In the case of Smart Operation Panel (Hybrid mode): 

Application Version Note 

CAP V2 Z11 V2.x  

CAP V2.x  

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application. Only for v2.3.0 or later. 

 
In the case of Smart Operation Panel (Full Native mode): 

Application Version Note 

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application.  

CAP Java Card Plug-in V1.x Smart Operation Panel application.  
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Activation Check 

1. In the case of CAP v2 (Hybrid mode/ Full Native mode), restart the device manually to enable 
authentication internally. 

 
2. Press [User Tools/Counter] button, and then press [Extended Feature Settings]. 

 

 
3. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not been activated yet. Wait 

for a while until [JavaTM Platform] appears. 
 

4. Press [Extended Feature Settings]. 
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5. Press [Startup Setting] tab, and confirm that the condition of each application is the same as below: 
In the case of Standard Operation Panel and Smart Operation Panel (Compatibility mode): 

Application Status 

CAP V2 MP11/MP21/MP31/SP31 Starting Up 

CAP LAUNCHER 

Suspend 

 
The Launcher is disabled by default. 
Please set it as the “Priority”. 
The Launcher is not supported on 
4.3-inch operation panel models. 

CAP Starting Up 

CAP REG Stop 

JavaTM Platform Starting Up 

 
In the case of Smart Operation Panel (Hybrid mode): 

Application Status 

CAP V2 Z11 Starting Up 

CAP Starting Up 

JavaTM Platform Starting Up 

 
In the case of Smart Operation Panel (Hybrid mode / Full Native Mode), please also check whether 
the following applications are installed in Home screen  Screen Features  Screen Device 
Settings Information  Software Version List: 

Application Note 

CAP V2 Auth. UI  

CAP User Config.  

CAP NFC plug-in Only for v2.3.0 or later. 

 
In the case of Smart Operation Panel (Full Native mode): 

Application Note 

CAP V2 Auth. UI  

CAP User Config.  

CAP NFC plug-in  

CAP Java Card Plug-in Only for CAP v2.5.0 or later. 
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The following SP modes are automatically set whenever the applications are started up (Every time 
when the machine power is turned on). In the case of Smart Operation Panel models, press the [x] 
button on the login screen and select the [Printer] icon after logging out, and then go into SP mode. 
It is not possible to log in to SP mode from User Tools or Quick application (such as Quick Copy) 
and when logged in to the device. 

 SP5-401-103: [0]  [3] 

 SP5-401-162*1: bit0 [0]  [1], bit3 [0]  [1] *2, bit5 [0]  [1] 

 SP5-401-230: bit0 [0]  [1], bit3 [0]  [1] *3 

 SP5-401-240: bit0 [0]  [1] 
*1 The bit6 of SP5-401-162 is changed from [0] to [1] at the first time when an IC card is touched. 
However, this is a normal action. 
 The value of SP5-401-162 will not be changed by installing CAP (F12) 
*2 It changes automatically when “Card Login Method” is set to “Enter Password from the Control 
Panel”. 
*3 It changes automatically when the Billing Code function is used. 

 [Standard Operation Panel model] Priority Feature Setting  

This setting is not required with Smart Operation Panel model. 
1. Press [User Tools/Counter] button, and then press [System Settings]. 

 
2. Press [General Features] tab, and then press [Function Priority]. 

 
3. Select [Java TM/X] and press [OK]. 
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[Smart Operation Panel model] Specific settings 

Icon Setting (Only for 15S or later Smart Operation Panel models): 

CAP User Config. Tools can be displayed on Home screen. 
1. Log in to the MFP as an Administrator. 
2. Press the square button on the right side of the panel.

 
 

3. Press and hold the CAP User Config icon under [APPS] tab. This operation will locate the icon on 
Home Screen. 

 
4. CAP User Config icon will appear. 
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Icon Setting (Only for 15S or before Smart Operation Panel models): 

CAP User Config. Tool can be displayed on Home screen. 
 

1. Log in to the MFP as an Administrator. 
2. Press and hold Home screen. The [Add to Home] screen will appear. 
3. Select [Icon]. 

 
4. Select [Application]. 

 
5. Select [CAP User Config.]. 
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6. CAP User Config. icon will appear. 

 
 

Screen device always-connection Setting (15S or later models) 

 
1. Shift to Screen service mode.  

 
For information on how to enter Screen service mode, contact the supervisor in your branch office. 

2. Select [Screen Device Settings]. 
3. Enable [Screen device always-connection Setting]. 
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Recommendation: Energy Saving Recovery for Business Application setting (15S or 
later 

If the setting is “On”, login may be little slow at the first time after recovering the energy saving. We 
recommend setting this as “Off”. 
1. Log in to the MFP as an Administrator. 
2. Select [User Tools]. 
3. Select [Machine Features]. 
4. Select [System Settings]. 
5. Select [Energy Saving Recovry. for Business Applicatn.]. 

 
6. Set to [Off] and select [OK]. 
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Priority Feature Setting (Compatibility mode): 

It is possible to select CAP LAUNCHER as a default application when a user logs in to the device.  
 
How to configure Function Priority: 
1. Log in to the MFP as an Administrator. 
2. Select [Screen Features]. 

  
3. Select [Screen Device Settings]. 

 
4. Select [Function Priority]. 
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5. Select [CAP LAUNCHER]. 

  
 

Authentication priority mode (For Hybrid mode / Full Native mode): 

When a device is in sleep mode, it takes more time for a user’s job list to be displayed after the user 
swipes their IC card on Smart Operation Panel models for Hybrid mode than it does on Standard 
Operation Panel models and Smart Operation Panel models (Compatibility mode). 
 
By setting the Authentication priority mode via the Screen service mode, the print job display for Hybrid 
mode is about as fast as the Standard Operation Panel models and Smart Operation Panel models 
(Compatibility mode). This setting means the HDD always starts within a designated time and it takes 
little time to authenticate the user information. However, this may negatively affect the TEC value (TEC 
= Typical Electricity Consumption). The procedure for setting it is as follows. 
1. Shift to Screen service mode.  

 
 For information on how to enter Screen service mode, contact the supervisor in your 

branch office. 
2. Select [Screen Device Settings]. 
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3. Select [Authentication priority mode]. 

 
4. Select [Start time(hhmm)] and enter the desired start time(hhmm). Also, select [Expiration 

time(hours)] and enter the desired expiration time(hours). It is possible to input the desired hour 
which is value of 1-10 hour(s). 
Their settings mean that it is time for Authentication priority mode to start and expire. 

 
5. Check [Authentication priority mode]. 

 
6. Logout. 
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Installation (4-line MFP/4-line LP/LP) 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

Set the following network information from system settings in the device. 
 Host Name 
 IP Address 
 Subnet Mask 
 Default Gateway 
 DNS Server 1 
 DNS Server 2 
 DNS Server 3 
 Domain Name 

VM Card Installation 

1. Set [Energy Saver Timer] to 5 minutes in [User Tools / Counter / Enquiry] screen  [System 

Settings]  [Timer Settings] tab. 

 
 [Energy Saver Timer] at the device side should be set to 5 minutes to prevent the device 

from entering the Energy Saver mode while the Java TM Platform is installing or activating. 
2. Insert the VM card into the SD card slot. 

 
 For which the SD card slot should be inserted into, see the service manual of each 

machine. 
3. Turn on the main power of the device. 

 

The device network environment 

settings 

The VM Card Installation 

The Reader/writer connection for 

the IC Card 

The Installation environment setting 

Installation 

Priority feature setting 

1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 
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 The Java TM Platform is installed automatically if the main power of the device is turned on 
after the VM card insertion. 

 It takes for approx. from 3 to 4 minutes to install it automatically. 
 Never turn off the power of the device during the installation, otherwise it may damage the 

VM card. Turn off the power after the confirmation in step 8 has been done. 
4. Access to the machine with Web Image Monitor. 
5. Log in the machine as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

 
6. Click [Configuration] in the left menu. 

 
7. Click [Startup Setting] in [Extended Feature Settings] menu. 

 
8. Confirm that the status of [JavaTM Platform] is [Starting Up]. 
9. Click [Back]. 

 
10. Click [Administrator Tools] in [Extended Feature Settings] menu. 

 
11. Set [Heap Size] to 16 MB, and set [Stack Size] to 64 KB. 
12. Click [Apply]. 
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13. Log out from Web Image Monitor. 
14. Select [Shutdown] from the menu of the device. 

 
 Never turn off the power of the device before the shutdown, otherwise the HDD may be 

damaged. 
15. Turn off the power. 

 
 The VM card should be operated with setting in the SD card slot. 

IC Card Reader/Writer connection 

 
 The installation should be executed after the main power is turned off. 

Connect the IC card Reader/Writer to the device. 
 

Authentication Management Settings 

1. Open Web Image Monitor. 
2. Log in Web Image Monitor as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Administrator Authentication Management] in [Device Settings] menu. 

 
5. Check [On] at the following items. 

[User Administrator Authentication] 
[Machine Administrator Authentication] 
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[Network Administrator Authentication] 
[File Administrator Authentication] 

6. Click [OK], and enable settings. 

 
7. Click [User Authentication management] in [Device Settings] menu. 

 
8. Remove all check marks in [Available Function: Printer] of [LDAP Authentication Settings] or 

[Custom Authentication Settings]. 
9. Click [OK], and enable settings. 
10. Log out from Web Image Monitor. 
11. Select [Shutdown] from the menu of the device. 
12. Turn off and on the power of the device. 

Card Authentication Package V2 Installation 

For the Card Authentication Package V2 installation, install it with Remote Install Manager. See the 

service manual of Remote Install Manager. (  Remote Install Manager) 

Automatic Startup Settings 

The following applications should be set to start up automatically. 
 CAP 
 CAP LAUNCHER 
 CAP V2 MP21/SP11 
1. Open Web Image Monitor. 
2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 
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3. Click [Configuration] in the left menu. 

 
4. Click [Startup Setting] in [Extended Feature Settings] menu. 

 
5. Click [Details] icon of [Extended Feature Name] for the target application. 

 
6. Check [On] at [Auto Start] and click [OK]. 
7. Reboot the device. 
 

Installation Check 

1. Turn on the power of the device. 
2. Log in Web Image Monitor as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 
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4. Click [Extended Feature Info] in [Extended Feature Settings] menu. 
5. Refer to the application list, and confirm that the condition of each application is the same as below: 

 

Application Status 

CAP V2 MP21/SP11 Starting Up 

CAP LAUNCHER Suspend 

CAP Starting Up 

CAP REG Stop 

JavaTM Platform Starting Up 

 

Priority Feature Setting 

1. Press [Maintenance]  [General Settings]  [Function Priority] from the menu of the device. 
2. Select [Java TM/X]. 

 
 The procedure of this setting differs from devices so that see the service manual of the device. 

  



 Technical Bulletin PAGE: 33/48 

Reissued: 26-Dec-18 

Model: Card Authentication Package v2 Date: 12-Mar-12 No.: RD602007l 
 

 

Installation (Pre-include model) 

18S or later models with Smart Operation Panel have CAP installer in devices. 
CAP can be installed to these models via Smart Operation Panel so Remote Install Manager is not 
required. 
 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

“Please refer to “Installation Environment Settings” in “Installation (Smart Operation Panel/WVGA/ 
4.3-inch operation panel models)” section 

IC Card Reader/Writer Connection (NFC R/W) 

“Please refer to “IC Card Reader/Writer Connection (NFC R/W)” in “Installation (Smart Operation Panel/ 
WVGA/4.3-inch operation panel models)” section 

Authentication Management Settings 

“Please refer to “Authentication Management Settings” in “Installation (Smart Operation Panel/ 
WVGA/4.3-inch operation panel models)” section 
 
  

Installation environment settings 

The Reader/writer connection for 

the IC Card (NFC R/W) 

 

Authentication Management 

settings 

 

Smart Operation Panel model 

specific settings 

1: Checking the version of the device firmware  

2: Installation and activation of the applications 

3: Installation confirmation 

Installation 
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Installation of CAP v2 

The installation method of and “CAP” to 18S or later models with Smart Operation Panel models is as 
below. 

1) Display the legacy application on Cheetah’s operation panel, and login by operation SP 
mode. 

2) Choose “Device” > “Apps”. 
3) Choose “Install” 
4) Choose ”Install From Internal Storage” 
5) Install the following applications one by one (applications cannot be installed at the same 

time). 
 CAP V2 Auth.UI 
 CAP User Config. 
 CAP NFC Plug-in 
 CAP Java Card Plug-in 

Application installation is now completed.   
 
Next, activate the application. 
6) Return to the screen in the step 4, choose ”Activate Applications” 
7) Choose the following applications one by one, and input the product key and “Execute” for 

each. 
 CAP V2 Auth.UI 

8) After Activation is completed, restart the device. 
 

Activation Check 

“Please refer to Full Native mode of “Activation Check” in “Installation (Smart Operation 
Panel/WVGA/4.3-inch operation panel models)” section 

[Smart Operation Panel model] Specific settings 

“Please refer to “[Smart Operation Panel model] Specific settings” in “Installation (Smart Operation 
Panel/WVGA/4.3-inch operation panel models)” section 
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When Migrate to Card Authentication Package v2 from v1 

Migration from Card Authentication Package v1 to v2 requires the conversion of the user information 
from Card Authentication Package v1’s format to v2’s format. 
The following explains the conversion procedure using CAP Convert Tool. 

 
 For CAP Convert Tool, JRE v6.0 or later is required on the host PC. 

Conversion Flowchart 

 

Export the Data 

The following three files are required in order to convert the Card Authentication Package v1 data into 
v2 data. 
 Card information file: card(date).csv 
 User information file: (model name)_user.csv 
 Address information file: (model name)_addr.csv 
These exports have to be done before uninstalling v1. 
1) Export the card information 
1. Click [Maintenance] to show [Card ID Mapping Maintenance] screen. 

 
2. Click [Export]. 
The export operation creates a CSV file containing the card information. 
Example: cardmmdd.csv (mmdd: an exported month (mm) and day (dd)) 
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2) Export the user information 

 
1. Launch [User Management Tool] of Smart Device Monitor for Admin. 

 
2. Select [Access Control List] tab. 

 
3. Select [Export User Information] from [File] menu. 
The user information is exported as a CSV file. 
Example (for an Aficio MP C5000): Aficio_MP_C5000_user.csv 
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3) Export the address information 

 
 
1. Launch [Address Management Tool] of Smart Device Monitor for Admin. 

 
2. Select [Export Data] from [File] menu. 
Three CSV files are created by the export process and one of them is needed for the conversion. 
Example (for an Aficio MP C5000): 
Aficio_MP_C5000_faxinfo.csv 
Aficio_MP_C5000_taginfo.csv 
Aficio_MP_C5000_addr.csv (Only this file is needed for the conversion.) 

Uninstall Card Authentication Package v1 

For the Card Authentication Package v1 uninstallation, see the service manual for Card Authentication 

Package v1. (  Card Authentication Package v1 Service Manual) 

Install Card Authentication Package v2 

For the Card Authentication Package v2 installation, install it with Remote Install Manager. See the 

service manual of Remote Install Manager. (  Remote Install Manager) 

Convert the Data Format 

1. Before running CAP Convert Tool, put the tool and the files into the same directory. 
 CAP Convert Tool: DataConvertFromCap.exe 
 Card information file: card(date).csv 
 User information file: (model name)_user.csv 
 Address information file: (model name)_addr.csv 

2. CAP Convert Tool is a command-line tool. Open a command prompt and switch to the directory 
where the files are located. 

3. Enter the following command. 
DataConvertFromCap.exe (User information file name) (Address information file name) (Card 
information file name) [Character-code] 
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 If any character code is not specified, “Cp1252” will be used as a default. 
 For a list of supported character encoding types, refer to the 2nd column of the following 

list: 
 http://download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html 

4. A message is displayed when the conversion is complete. The message includes the following 
information: 
 User information registered (total item) 
 Convert user information items (succeeded) 
 Input format error items (failed) 
 Conversion error items (failed) 
If there is no error, close the command prompt. 

Import the Data 

A successful conversion creates the following two files: 
 DataConvertFromCap.csv 

This is the user information file for Card Authentication Package v2. 
To import the data, use CAP v2 Configuration Tool. 

 DataConvertFromCap.log 
This log contains the conversion results and the error information. 
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Uninstallation 

Uninstallation 

Uninstallation (Smart Operation Panel/WVGA/4.3-inch operation panel models) 

 Depending on the device model, the actual operation panel screen may look different from the 
screenshots used in this document. 

[Smart Operation Panel model] Specific settings (Hybrid mode / Full Native mode) 

Set “Authentication Priority mode (Hybrid mode / Full Native mode)” via the Screen service mode to off. 
 
1. Shift to Screen service mode.  

 
 For information on how to enter Screen service mode, contact the supervisor in your 

branch office. 
2. Select [Screen Device Settings]. 

 
 
3. Select [Authentication priority mode]. 
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4. Clear the check box for [Authentication priority mode]. 

 
 
5. Logout. 
 

Setting in the Device 

1. Log in the device as an administrator. 
2. Set [Enhanced Authentication Management]* to [Off]. 

*[System Settings]->[Administrator Tools]->[Enhanced Authentication management] 
 

 
 The SC636 error will occur when ignoring the process above. 

 

Priority Feature Cancellation 

In the case of Standard Operation Panel models: 
1. Press the [User Tools/Counter] button. Then, press [System Settings]. 
2. Select the [General Features] tab. Then, press [Function Priority]. 
3. Select any item on the screen other than [Java TM/X] and press [OK]. 
 

Authentication Management Settings 

1. Log in the device as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

2. Press [User Tools/Counter] button, and then press [System Settings]. 
*With 15S or later models, select [User Tools] -> [Machine Features] -> [System Settings] 

3. Press [Administrator Tools] tab, and set items below: 
4. [User Authentication Management] 
5. [Administrator Authentication Management] 

1) User Authentication Management 
1. Set the method of the authentication is “Off”. 
2. Press [OK] of the upper right. 
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2) Administrator Authentication Management 
[User management] 
1. Set [Admin. Authentication] to [Off]. 
 [Machine Management] 
2. Set [Admin. Authentication] to [Off]. 
 [Network Management] 
3. Set [Admin. Authentication] to [Off]. 
 [File Management] 
4. Set [Admin. Authentication] to [Off]. 
5. Press [OK] of the upper right. 
Turn the power off and on after the settings are completed. 
 

How to stop applications 

With Smart Operation Panel models (Hybrid mode): 
1. Login to the device as an administrator. 
2. Choose [User Tools] -> [Machine Features] -> [System Settings] -> [Extended Feature Settings] -> 

[Extended Feature Settings]. 
3. Choose [Startup Setting] tab, and press following applications one by one: 

 CAP V2 Z11 
 CAP 

Press [CAP V2 Z11], then the application will be stopped. 
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4. Choose [Extended Feature Info] tab. 
5. Press an application name. 

 
6. Set [Auto Start] to "Off". Then press [Exit]. 

 
7. Conduct the same procedure for the following applications as well: 

 CAP V2 Z11 
 CAP 
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Uninstallation of CAP v2 

Uninstall the following applications using Remote Install Manager to uninstall CAP. For the 

uninstallations procedures of these applications, see the service manual of Remote Install Manager. (  
Remote Install Manager) 
 
In the case of Standard Operation Panel models and Smart Operation Panel models (Compatibility 
mode): 
 CAP V2 MP11/MP21/MP31/SP31 
 CAP LAUNCHER 
 CAP 
 CAP REG 
 
In the case of Smart Operation Panel models (Hybrid mode): 

Application Version Note 

CAP V2 Z11 V2.x  

CAP V2.x  

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x 
Smart Operation Panel application. Only for v2.3.0 or 
later. 

 
In the case of Smart Operation Panel models (Full Native mode): 

Application Version Note 

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application.  

CAP Java Card Plug-in V1.x 
Smart Operation Panel application. Only for v2.5.0 or 
later. 

 

 
If “RTY-003 : Communication timeout has occurred between the devices. (N002)” is displayed on 
Remote Install Manager after uninstallation, please try to restart the device manually and perform [Re-
execute Errored Operation...] from the Device Operation menu. If the error still appears even though the 
operation is performed, check the error for troubleshooting in Remote Install Manager Service Manual. 
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SP Mode Cancellation 

Restore the SP values described below. In the case of Smart Operation Panel models, press the [x] 
button on the login screen and select the [Printer] icon after logging out, and then go in to SP mode. It is 
not possible to log in to SP mode from User Tools or Quick application (such as Quick Copy) and when 
logged into the device. 
 

SP5-401-103: [3]  [0] 

SP5-401-162: bit0 [1]  [0], bit3 [1]  [0], bit5 [1]  [0], bit6 [1]  [0] 

SP5-401-230: bit0 [1]  [0], bit3 [1]  [0] 

SP5-401-240: bit0 [1]  [0] 

 
 The machine should be rebooted after the settings are changed. 
 The setting changes are not necessary if the reinstallation is executed. 
 Depending on the functions the customer uses, not all of the above SP values may be set 

to [1] even before cancelling them. 
 The value of SP5-401-162 will not be changed by installing “ELP-NX with CAP (F12)” 
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Uninstallation (4-line MFP/4-line LP/LP) 

Setting in the Device 

Set [Enhanced Authentication Management] in [Security Management] to [Off]. 

 
 The SC636 error will occur when ignoring the process above. 

Setting with Web Image Monitor 

1. Open Web Image Monitor. 
2. Log in the machine as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [User Authentication Management] in [Device Settings] menu. 

 
5. Select [Off] at [User Authentication Management], and click [OK]. 

 
6. Click [Administrator Authentication Management] in [Device Settings] menu. 
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7. Check [Off] at the following items, and click [OK]. 

 User Administrator Authentication 
 Machine Administrator Authentication 
 Network Administrator Authentication 
 File Administrator Authentication 

8. Turn off and on the power of the device. 
9. Execute the uninstallation with Remote Install Manager. For details, see the service manual of 

Remote Install Manager. (  Remote Install Manager) 
 CAP V2 MP21/SP11 
 CAP LAUNCHER 
 CAP 
 CAP REG 
For the uninstallation procedures of these applications, see the service manual of Remote Install 

Manager. (  Remote Install Manager) 
 

SP Mode Cancellation 

Restore the SP values described below. 

 SP5-401-103: [3]  [0] 

 SP5-401-162: bit0 [1]  [0], bit5 [1]  [0] 

 SP5-401-230: bit0 [1]  [0] 

 SP5-401-240: bit0 [1]  [0] 

 
 The machine should be rebooted after the settings are changed. 
 The setting changes are not necessary if the reinstallation is executed. 

Priority Feature Cancellation 

1. Press [Maintenance]  [General Settings]  [Function Priority] from the menu of the device. 
2. Select an item on the screen other than [Java TM/X]. 

 
 The procedure of this setting differs from devices so that see the service manual of the device. 
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Appendix 

VM Card Update 

 
 The steps below should be followed when updating the VM card if CAPv2 is installed. 

 

1. Disable Enhanced Authentication Management (SP5-401-160: [1]  [0]). 

 
 Proceed to step 2 without rebooting the device. 

2. Update the VM card using Remote Install Manager.  
3. Reboot the device two times (some settings are automatically set during the 1st reboot that require 

a 2nd reboot to enable). 
 

Procedure for changing the HDD 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all the applications (CAP) using Remote Install Manager. 
3. Change out the HDD. 

 
 Please refer to the device service manual to change out the HDD. 

 
4. Reinstall all the applications (CAP) using Remote Install Manager. 
5. Import the user/device setting in Configuration Tool. 
3. File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 

button. 
 
 

Procedure for changing the controller board 

This procedure is available in the case that Java VM is installed to the device’s flash memory (FM) on 
the controller board. 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible.) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all applications (CAP) via Remote Install Manager. 

 
 In the case that the controller board needs to be replaced when using Hybrid mode: 

If it is necessary to replace the controller board, the Smart Operation Panel applications 
will remain. Therefore, the applications should be uninstalled using RIM. 
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3. Disable the Java VM (SP5-730-001: [1] -> [0]). Then restart the device. 
4. Change out the controller board. 

 
 Please refer to the device service manual to change out the Controller Board. 

 

5. Reinstall all the applications (CAP) using Remote Install Manager. 
6. Import the user/device setting in configuration tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 

 
 

Procedure for changing the Smart Operation Panel  

This procedure is available when changing to a Smart Operation Panel from a Standard Operation 
Panel or if a Smart Operation Panel needs to be replaced. 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible.) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all applications (CAP) via Remote Install Manager.  

 
 In the case that the Smart Operation Panel needs to be replaced when using Hybrid mode: 

If it is necessary to replace the Smart Operation Panel, the DSDK applications installed 
in the Java VM will remain. Therefore, these applications should be uninstalled via Web 
image Monitor. The uninstallation method via Web Image Monitor is as follows. 

WIM -> Configuration -> “Uninstall” in Extended Feature Settings 
 

 The reason for why the DSDK applications must be uninstalled via WIM is as follows: 
As per the specification for the eDC-i system, the DSDK applications installed in the 
Java VM and the Smart Operation Panel applications are regarded as 1 application. 
When the Smart Operation Panel is replaced (the DSDK applications are left and the 
Smart Operation Panel applications disappear), the eDC-i system will judge that both 
the DSDK applications and the Smart Operation Panel applications are deleted. This 
will cause an error to occur when uninstalling via RIM. Therefore, it is necessary to 
uninstall the remaining DSDK applications via WIM in order to clear the error in RIM. 
 

 In the case that the Smart Operation Panel needs to be replaced when using Hybrid mode: 
It is necessary to forcibly deactivate the license key in advance. Please contact the 
marketing section in your branch office regarding the deactivation method. 
 

3. Reinstall all applications (CAP). 
4. Import the user/device settings via the Configuration Tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 
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Installation 

Installation 

Before installation, please make sure all firmware (GW firmware, Smart Operation Panel firmware, and 
Smart Operation Panel applications) are the latest version. Regarding the firmware update procedures, 
please refer to the device service manual. 

Installation (Smart Operation Panel/WVGA/4.3-inch operation panel models) 

 Depending on the device model, the actual operation panel screen may look different from the 
screenshots used in this document. 

 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

1. Network information 
* Setting from [System Settings] on [User Tools / Counter / Enquiry] screen of the device. 
* In the case of Smart Operation Panel models, [User Tools] must be selected first and then the [User 
Tools / Counter / Enquiry] screen is displayed. 

 

The device network environment 

settings 

The VM Card Installation 

The Installation environment setting 

Installation 1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 

Priority feature setting  

(Only for Standard Operation Panel 

models) 

Smart Operation Panel model 

specific setting  

(Only for Smart Operation Panel 

models) 
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Item Detailed descriptions Default/Remarks 

Host 
Name 

Set the host name shown on [Interface Settings] tab. 
This setting is performed on the screen keyboard. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

IP 
Address/ 
Subnet 
Mask 

Set the IP address and the subnet mask that appear when 
[Machine IPv4 Address] in [Interface Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
addresses with the numeric keys on the operation panel. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

Default 
Gateway 

Set the address that appears when [IPv4 Gateway Address] in 
[Interface Settings] tab is selected. 
For setting, enter the address with the numeric keys on the 
operation panel. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

DNS 
Server 
1/DNS 
Server 
2/DNS 
Server 
3 

Set the server addresses that appear when [DNS Configuration] 
in [Interface Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
addresses with the numeric keys on the operation panel. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

Domain 
Name 

Set the name that appears when [Domain Name] in [Interface 
Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
name with the screen keyboard. 

 

 

- 

 
1. Timer Setting 
* Setting from [System Settings] on [User Tools / Counter / Enquiry] screen of the device. 

 

Item Detailed descriptions Default/Remarks 

Auto 
Logout 
Timer 

The default value is [Off], however press [Auto Logout Timer] in 
[Timer Settings] tab and select [On] to enter the logout time if 
necessary to change it. 
The range of entering the automatic logout time is from 60 to 
999 seconds. 

Default: [Off] 
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VM Card Installation 

 
 If the JavaVM is installed to the device’s Flash Memory (FM), this procedure is not 

necessary. In this case, please proceed to the “JavaVM Configuration” 
 If JavaVM is not installed to the device, this procedure is not necessary. In this case, please 

proceed to the “Installation of Enhanced Locked Print NX V2” 
 

1. Set [Auto Off Timer] to 5 minutes in [User Tools / Counter / Enquiry] screen  [System Settings]  
[Timer Settings] tab. 

 
 [Auto Off Timer] at the device side should be set to 5 minutes to prevent the device from 

entering the Auto Off mode while the Java TM Platform is installing or activating. 

2. Set [System Auto Reset Timer] to [Off] in [User Tools / Counter / Enquiry] screen  [System 

Settings]  [Timer Settings] tab. 

 
 This setting should be restored after the installation. 

3. The main power of the device is turned off. 
4. Insert the VM card into the SD card slot. 

 
 For which the SD card slot should be inserted into, see the service manual of each 

machine. 
5. Turn on the main power of the device. 

 
 The Java TM Platform is installed automatically if the main power of the device is turned on 

after the VM card insertion. 
 It takes for approx. 3 to 4 minutes to install it automatically. 
 Never turn off the power of the device during the installation, otherwise the VM card may 

be damaged. Turn off the power after the confirmation in step 8 has been done. 
6. Press [User Tools/Counter] button. 
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7. Press [Extended Feature Settings] after [User Tools / Counter / Enquiry] screen appears. 

 
8. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears after the 

installation is completed normally. 
 

JavaVM Configuration 

1. Press [User Tools/Counter] button. 
2. Press [Extended Feature Settings] after [User Tools / Counter / Enquiry] screen appears. 
3. Press [Extended Feature Settings]. 
4. Press [Administrator Tools] tab, and then press [Heap / Stack Size Settings]. 

 
5. Set the heap size and the stack size.  

Model Heap size Stack size 
11S or earlier 16MB (Default: 10MB) 64KB (Default: 64KB) 
11A or later 48MB (Default: 16MB) Do not change from default size (Default: 256KB) 

6. Finish the initial settings. 
7. Push the power button at the side of the operation section. After the power indicator has finished 

blinking, turn off the main power. 

 
 The VM card should be operated with setting in the SD card slot. 
 Restore the original setting after installation if [System Auto Reset Timer] is changed.  
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Installation of Enhanced Locked Print NX V2 

Install the following applications using Remote Install Manager to install Enhanced Locked Print NX v2. 
For the installations procedures of these applications, see the service manual of Remote Install 

Manager. (  Remote Install Manager) 
 

 
 Regarding the installation method for Smart Operation Panel models (Compatibility mode), 

it is necessary to perform offline installation via RIM. It is not possible for the eDC-I system 
to judge which application module type (MP**: Compatibility mode / Z**: Hybrid mode) 
should be installed to devices equipped with the Smart Operation Panel. It is possible for 
Hybrid mode to perform online/offline installation via RIM. 

 
 In the case of 12A models (MET-C1, CH-C1, OR-C2), before installing ELP-NX v2, make 

sure that at least one SD card slot located on the rear side of the device (option slot or 
service slot) is empty. For details, please refer to the “Enhanced Locked Print NX v2 
Installation to 12A Models (MET-C1, CH-C1, OR-C2)” RTB. Other models (11A or earlier 
and 12A or later models) are not affected. 

 
 If installing ELP-NX F12 (Full Native mode), “Remote Install Manager v1.7.4” or later 

version is required. 
 

In the case of Standard Operation Panel and Smart Operation Panel (Compatibility mode): 

Application Version Note 

ELP-NX V2 
MP11/MP12/MP13/MP31/SP31 
/MP33/SP13 

V2.x 

MP11 (12S or older WVGA models) 
MP12 (12A or later WVGA models) 
MP13(Only for Ricoh Asia Pacific. It needs to be 
installed offline. Target devices: Metis-C2 / Charis-C2 
/ Martini-C6 / Griffin-C2 / Corona-C1.5) 
MP31 (12A or older 4.3-inch operation panel MFP 
models)  
MP33 (15S or later 4.3-inch operation panel LP 
models) 
SP13 (15S or later 4-line LCD LP models) 
SP31 (12S or later 4.3-inch operation panel LP 
models) 

ELP NX V2.x  

FR Filter V1.x 
08S or older models must install the FR Filter 
manually. 

 
In the case of Smart Operation Panel (Hybrid mode): 

Application Version Note 

ELP-NX V2 Z12 V2.x  

ELP Service V2.x  

FR Filter V1.x  

ELP NX V1.x Smart Operation Panel application. 
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In the case of Smart Operation Panel (Full Native mode): 

Application Version Note 

ELP NX V1.x Smart Operation Panel application. 

 

Installation of FR Filter 

 
 Note that using Remote Install Manager will install the FR Filter automatically for 08A or 

later models. 
 When installing ELP-NX (F12), FR Filter is not installed but the function of “EGS” module 

in the controller is enabled.  

* SP mode (Special Service) “1-001-016”: bit6 [0]  [1] 
1. Press [User Tools/Counter] button. 
2. Press [Extended Feature Settings] in [User Tools / Counter / Enquiry] screen. 
3. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not activated yet. Wait for a 

while until [JavaTM Platform] appears. 
4. Press [Extended Feature Settings]. 
5. Press [Install] tab and then press [SD card]. 
6. Select [FR Filter] in the applications list. 
7. Select [Machine HDD] for the install location and press [Next]. 
8. Confirm the information on the screen and press [OK] to start the installation. 
9. Press [Exit] on the installation completion screen. 
10. Push the power button at the side of the operation section. After the power indicator has finished 

blinking, turn off the main power. 
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Activation Check 

1. Turn on the main power of the device. 

 
2. Press [User Tools/Counter] button, and then press [Extended Feature Settings]. 

 
3. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not activated yet. Wait for a 

while until [JavaTM Platform] appears. 
4. Press [Extended Feature Settings]. 
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5. Confirm on [Startup Setting] tab that the condition of each application is the same as below: 
In the case of Standard Operation Panel and Smart Operation Panel (Compatibility mode): 

Application Status 

ELP-NX V2 
MP11/MP12/MP31/SP31 

Starting Up 

ELP NX Suspend 

JavaTM Platform Starting Up 

FR Filter Waiting 

 
In the case of Smart Operation Panel (Hybrid mode): 

Application Status 

ELP-NX V2 Z12 Starting Up 

ELP Service Starting Up 

JavaTM Platform Starting Up 

FR Filter Waiting 

 
In the case of Smart Operation Panel (Hybrid mode / Full Native mode), please also check whether 
the following application is installed in Screen Features  Screen Device Settings Information  
Software Version List: 

Application 

ELP NX 

 

 
In full native mode, the following SP modes (Special Service) are automatically set whenever the 
applications are started up (Every time when the machine power is turned on). In the case of Smart 
Operation Panel models, press the [x] button on the login screen and select the [Printer] icon after 
logging out, and then go in to SP mode (Special Service). It is not possible to log in to SP mode 
(Special Service) from User Tools or Quick application (such as Quick Copy) and when logged into 
the device. 

  SP mode (Special Service) “1-001-016”: bit6 [0]  [1] 
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[Standard Operation Panel model] Priority Feature Setting 

This setting is not required with Smart Operation Panel model. 
 

1. Press [User Tools/Counter] button, and then press [System Settings]. 

 
 
2. Press [General Features] tab, and then press [Function Priority]. 

 
3. Select [Java TM/X] and press [OK]. 
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[Smart Operation Panel model] specific settings 

Icon Setting (Only for 15S or later Smart Operation Panel models): 

ELP-NX can be displayed on Home screen. 
1. Log in to the MFP as an Administrator. 
2. Press the square button on the right side of the panel. 

 
3. Press and hold the ELP NX icon under [APPS] tab. This operation will locate the icon on Home 

Screen. 

 
4. ELP NX icon will appear. 
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Icon Setting (Only for 15S or before Smart Operation Panel models): 

ELP-NX can be displayed on Home screen. 
 
1. Log in to the MFP as an Administrator. 
2. Press and hold Home screen. The [Add to Home] screen will appear. 
3. Select [Icon]. 

 
4. Select [Application]. 

 
5. Select [ELP NX].  
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6. ELP NX icon will appear. 

 
 

Screen device always-connection Setting (15S or later models) 

1. Shift to Screen service mode.  

 
For information on how to enter Screen service mode, contact the supervisor in your branch office. 

2. Select [Screen Device Settings]. 
3. Enable [Screen device always-connection Setting]. 
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Recommendation: Energy Saving Recovery for Business Application setting (15S or 
later models) 

If the setting is “On”, job list may be obtained slowly at the first time after recovering the energy saving. 
We recommend setting this as “Off”. 
1. Log in to the MFP as an Administrator. 
2. Select [User Tools]. 
3. Select [Machine Features]. 
4. Select [System Settings]. 
5. Select [Energy Saving Recovry. for Business Applicatn.]. 

 
6. Set to [Off] and select [OK]. 
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Priority Feature Setting (For Compatibility / Hybrid mode / Full Native mode): 

It is possible to select ELP NX as a default application when a user logs in to the device. 
 
How to configure Function Priority: 
1. Log in to the MFP as an Administrator. 
2. Select [Screen Features]. 

*With 15S or later models, select [User Tools] -> [Screen Features] 

  
3. Select [Screen Device Settings]. 

 
4. Select [Function Priority]. 
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5. Select [ELP NX].  

 
 

  



 Technical Bulletin PAGE: 22/33 

Reissued: 28-January-16 

Model: Enhanced Locked Print NX v2 Date: 12-Mar-12 No.: RD602008m 
 

 

Installation (4-line MFP/4-line LP/LP) 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

Set the following network information from system settings in the device. 
 Host Name 
 IP Address 
 Subnet Mask 
 Default Gateway 
 DNS Server 1 
 DNS Server 2 
 DNS Server 3 
 Domain Name 

Installation of VM Card 

1. Set [Energy Saver Timer] to 5 minutes in [User Tools / Counter / Enquiry] screen  [System 

Settings]  [Timer Settings] tab. 

 
 [Energy Saver Timer] at the device side should be set to 5 minutes to prevent the device 

from entering the Energy Saver mode while the Java TM Platform is installing or activating. 
2. Turn off the main power of the device. 
3. Insert the VM card into the SD card slot. 

 
 For which the SD card slot should be inserted into, see the service manual of each 

machine. 
4. Turn on the main power of the device. 

 
 The Java TM Platform is installed automatically if the main power of the device is turned on 

after the VM card insertion. 
 It takes for approx. 3 to 4 minutes to install it automatically. 
 Never turn off the power of the device during the installation, otherwise the VM card may 

be damaged. Turn off the power after the confirmation in step 9 has been done. 

The device network environment 

settings 

The VM Card Installation 

The Installation environment setting 

Installation 

Priority feature setting 

1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 



 Technical Bulletin PAGE: 23/33 

Reissued: 28-January-16 

Model: Enhanced Locked Print NX v2 Date: 12-Mar-12 No.: RD602008m 
 

 

5. Access to the device through Web Image Monitor. 
6. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
7. Click [Configuration] in the left menu. 

 
8. Click [Startup Setting] in [Extended Feature Settings] menu. 

 
9. Confirm that the status of [JavaTM Platform] is [Starting Up]. 
10. Click [Back]. 

 
11. Click [Administrator Tools] in [Extended Feature Settings] menu. 

 
12. Set [Heap Size] to 16 MB, [Stack Size] to 64 KB. 
13. Click [Apply]. 
14. Log out from Web Image Monitor. 
15. Select [Shutdown] from the menu of the device. 

 
 Never turn off the power of the device before the shutdown, otherwise the HDD may be 

damaged. 
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16. Turn off the main power. 

 
 The VM card should be operated with setting in the SD card slot. 

Enhanced Locked Print NX V2 Installation 

For the Enhanced Locked Print NX V2 installation, install it with Remote Install Manager. See the 

service manual of Remote Install Manager. (  Remote Install Manager) 

FR Filter Installation 

 
 Note that using Remote Install Manager will install the FR Filter automatically for 08A or 

later models. 
1. Open Web Image Monitor. 
2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Install] in [Extended Feature Settings] menu. 
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5. Check [SD Card Slot] and click [Display Extended Feature List]. 

 
6. Select [Device HDD] for the install location and check [FR Filter] in the list, and then click [Install]. 

 
7. Click [OK] on confirmation screen. 

Installation Check 

1. Turn on the main power. 
2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Extended Feature Info] in [Extended Feature Settings] menu. 
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5. In the lists on [Extended Feature Info] screen, confirm that each status of the application is as in the 
following. 

 

Application name Status 

ELP-NX V2 MP21/SP11 Starting Up 

ELP NX Suspend 

JavaTM Platform Starting Up 

FR Filter Waiting 

 

Priority Feature Setting 

1. Press [Maintenance]  [General Settings]  [Function Priority] from the menu of the device. 
2. Select [Java TM/X]. 

 
 The procedure of this setting differs from devices so that see the service manual of the device. 
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Installation (Pre-include model) 

18S or later models with Smart Operation Panel have LP-NX installer in devices. 
ELP-NX can be installed to these models via Smart Operation Panel so Remote Install Manager is not 
required. 

Installation Flowchart 

 
 
 
 
 

  
 
 
 
 
 
 
 

 

Installation Environment Settings 

“Please refer to “Installation Environment Settings” in “Installation (Smart Operation Panel/WVGA/ 
4.3-inch operation panel models)” section 
 

Installation of Enhanced Locked Print NX V2 

The installation method of “ELP-NX” to 18S or later models with Smart Operation Panel models is as 
below. 

1) Display the legacy application on Cheetah’s operation panel, and login by operation SP 
mode. 

2) Choose “Device” > “Apps”. 
3) Choose “Install” 
4) Choose ”Install From Internal Storage” 
5) Install the following applications one by one (applications cannot be installed at the same 

time). 
 ELP NX 

Application installation is now completed.   
 
Next, activate the application. 
6) Return to the screen in the step 4, choose ”Activate Applications” 
7) Choose the following applications one by one, and input the product key and “Execute” for 

each. 
 ELP NX 

8) After Activation is completed, restart the device. 
  

The device network environment 

settings 

The Installation environment setting 

Installation 
1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 

Smart Operation Panel model 

specific settings 
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Activation Check 

“Please refer to Full Native mode of “Activation Check” in “Installation (Smart Operation 
Panel/WVGA/4.3-inch operation panel models)” section 

[Smart Operation Panel model] Specific settings 

“Please refer to “[Smart Operation Panel model] Specific settings” in “Installation (Smart Operation 
Panel/WVGA/4.3-inch operation panel models)” section 
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Uninstallation 

Uninstallation 

Uninstallation (Smart Operation Panel/WVGA/4.3-inch operation panel models) 

 Depending on the device model, the actual operation panel screen may look different from the 
screenshots used in this document. 

Priority Feature Cancellation 

In the case of Normal Operation Panel models: 
1. Press [User Tools/Counter] button, and then press [System Settings]. 
2. Press [General Features] tab, and then press [Function Priority]. 
3. Select an item on the screen other than [Java TM/X] and press [OK]. 
 

In the case of Smart Operation Panel models: 
1. Press [Screen Features] button, and then press [System Settings]. 

*With 15S or later models, select [User Tools] -> [Screen Features]  
2. Press [Function Priority]. 
3. Select an item on the screen other than [ELP NX] and press [OK]. 

Uninstallation of Enhanced Locked Print NX V2 

Uninstall the following applications using Remote Install Manager to uninstall Enhanced Locked Print 
NX V2. For the uninstallations procedures of these applications, see the service manual of Remote 

Install Manager. (  Remote Install Manager) 
 
In the case of Standard Operation Panel models and Smart Operation Panel models (Compatibility 
mode): 
 ELP-NX V2 MP11/MP12/MP13/MP31//MP33/SP31 
 ELP NX 
 FR Filter (08S or older models must uninstall the FR Filter manually.) 
 
In the case of Smart Operation Panel models (Hybrid mode): 

Application Version Note 

ELP-NX V2 Z12 V2.x  

ELP Service V2.x  

FR Filter V1.x  

ELP NX V1.x Smart Operation Panel application. 

 
In the case of Smart Operation Panel models (Full Native mode): 

Application Version Note 

ELP NX V1.x Smart Operation Panel application. 

  
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If “RTY-003 : Communication timeout has occurred between the devices. (N002)” is displayed on 
Remote Install Manager after uninstallation, please try to restart the device manually and perform 
[Re-execute Errored Operation...] from the Device Operation menu. If the error still appears even 
though the operation is performed, check the error for troubleshooting in Remote Install Manager 
Service Manual. 

 

Uninstallation of FR Filter 

 
 Note that using Remote Install Manager will uninstall the FR Filter automatically for 08A or 

later models. 
 When uninstall “ELP-NX (F12)”, this procedure is not necessary. 

1. Press [User Tools/Counter] button. 
2. Press [Extended Feature Settings]. 
3. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not activated yet. Wait for a 

while until [JavaTM Platform] appears. 
4. Press [Extended Feature Settings]. 
5. Press [Uninstall] tab and then select [FR Filter] in the applications list. 
6. Press [Yes]. 
7. Press [Yes]. 
8. Press [Exit]. 
9. Push the power button at the side of the operation section. After the power indicator has finished 

blinking, turn off the main power. 
10. Turn on the main power. 
11. Press [User Tools/Counter] button. 
12. Press [Extended Feature Settings] on [User Tools / Counter / Enquiry] screen. 
13. Press [Extended Feature Settings] on [Extended Feature Setting Menu] screen. 
14. Press [Uninstall] tab. 
15. Confirm that [FR Filter] is not shown in the applications list. 

 
 The main power should be turned off and on after the uninstallation. Otherwise the application 

may be reinstalled incorrectly. 

SP Mode Cancellation (Only Full native mode) 

Restore the SP values described below. In the case of Smart Operation Panel models, press the [x] 
button on the login screen and select the [Printer] icon after logging out, and then go in to SP mode 
(Special Service). It is not possible to log in to SP mode (Special Service) from User Tools or Quick 
application (such as Quick Copy) and when logged into the device. 
 

 SP1-001-016 bit6 [1]  [0] *SP mode (Special Service) 

 
 The machine should be rebooted after the settings are changed. 
 If SP1-101-016 bit6 remains [1], print jobs will still be stored in device even after 

uninstalling ELP. 
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Uninstallation (4-line MFP/4-line LP/LP) 

Priority Feature Cancellation 

1. Press [Maintenance]  [General Settings]  [Function Priority] from the menu of the device. 
2. Select an item on the screen other than [Java TM/X]. 

 
 The procedure of this setting differs from devices so that see the service manual of the device. 

Enhanced Locked Print NX V2 Uninstallation 

For the Enhanced Locked Print NX V2 uninstallation, uninstall it with Remote Install Manager. See the 

service manual of Remote Install Manager. (  Remote Install Manager) 
 

 
If “RTY-003 : Communication timeout has occurred between the devices. (N002)” is displayed on 
Remote Install Manager after uninstallation, please try to restart the device manually and perform 
[Re-execute Errored Operation...] from the Device Operation menu. If the error still appears even 
though the operation is performed, check the error for troubleshooting in Remote Install Manager 
Service Manual. 

 

FR Filter Uninstallation 

1. Open Web Image Monitor. 
2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Uninstall] in [Extended Feature Settings] menu. 
5. Select [FR Filter] in the applications list. 
6. Reboot the device. 
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Appendix 

VM Card Update 

 
 The steps below should be followed when updating the VM card if ELP-NX v2 is installed. 

 

1. Disable Enhanced Authentication Management (SP5-401-160: [1]  [0]). 

 
 Proceed to step 2 without rebooting the device. 

2. Update the VM card using Remote Install Manager.  
3. Reboot the device two times (some settings are automatically set during the 1st reboot that require 

a 2nd reboot to enable). 
 
 

Procedure for changing the HDD 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all the applications (ELP) using Remote Install Manager. 
3. Change out the HDD. 

 
 Please refer to the device service manual to change out the HDD. 

 
4. Reinstall all the applications (ELP) using Remote Install Manager. 
5. Import the user/device setting in Configuration Tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 

 
 

Procedure for changing the controller board 

This procedure is available in the case that Java VM is installed to the device’s flash memory (FM) on 
the controller board. 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible.) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all applications (ELP) via Remote Install Manager. 

 
 In the case that the controller board needs to be replaced when using Hybrid mode: 

If it is necessary to replace the controller board, the Smart Operation Panel applications 
will remain. Therefore, the applications should be uninstalled using RIM. 
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3. Disable the Java VM (SP5-730-001: [1] -> [0]). Then restart the device. 
4. Change out the controller board. 

 
 Please refer to the device service manual to change out the Controller Board. 

 

5. Reinstall all the applications (ELP) using Remote Install Manager. 
6. Import the user/device setting in configuration tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 

 
 

Procedure for changing the Smart Operation Panel  

This procedure is available when changing to a Smart Operation Panel from a Standard Operation 
Panel or if a Smart Operation Panel needs to be replaced. 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible.) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all applications (ELP) via Remote Install Manager.  

 
 In the case that the Smart Operation Panel needs to be replaced when using Hybrid mode: 

If it is necessary to replace the Smart Operation Panel, the DSDK applications installed 
in the Java VM will remain. Therefore, these applications should be uninstalled via Web 
image Monitor. The uninstallation method via Web Image Monitor is as follows. 

WIM -> Configuration -> “Uninstall” in Extended Feature Settings 
 

 The reason for why the DSDK applications must be uninstalled via WIM is as follows: 
As per the specification for the eDC-i system, the DSDK applications installed in the 
Java VM and the Smart Operation Panel applications are regarded as 1 application. 
When the Smart Operation Panel is replaced (the DSDK applications are left and the 
Smart Operation Panel applications disappear), the eDC-i system will judge that both 
the DSDK applications and the Smart Operation Panel applications are deleted. This 
will cause an error to occur when uninstalling via RIM. Therefore, it is necessary to 
uninstall the remaining DSDK applications via WIM in order to clear the error in RIM. 
 

 In the case that the Smart Operation Panel needs to be replaced when using Hybrid mode: 
It is necessary to forcibly deactivate the license key in advance. Please contact the 
marketing section in your branch office regarding the deactivation method. 
 

3. Reinstall all applications (ELP). 
4. Import the user/device settings via the Configuration Tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 
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RTB Reissue 
The items in bold italics were corrected or added. 
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Installation 

Installation 

Before installation, please make sure the firmware (GW firmware, Java VM, Smart Operation Panel 
firmware, and Smart Operation Panel applications) are the latest version. Regarding the firmware 
update procedures, please refer to the device service manual. 

Installation (Smart Operation Panel/WVGA/4.3-inch operation panel models) 

 Depending on the device model, the actual operation panel screen may look different from the 
screenshots used in this document. 

 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

1) Network information 
* Setting from [System Settings] on [User Tools / Counter / Enquiry] screen of the device. 
* See below for 15S or later Smart Operation Panel models: 
[User Tools] -> [Machine Features] -> [System Settings] on [User Tools] screen.  
Please follow this operation when you are to change the settings in  [System Settings] which are 
explained in the later sections of this document. 

Installation environment settings 

Installation of VM Card/JavaVM 

Configuration 

The Reader/writer connection for 

the IC Card 

Installation 

Priority feature setting  

(Only for Standard Operation Panel 

models) 

1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 

Authentication Management 

settings 

Smart Operation Panel model 

specific settings  

(Only for Smart Operation Panel 

models) 
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Item Detailed descriptions Default/Remarks 

Host 
Name 

Set the host name shown on [Interface Settings] tab. 
This setting is performed on the screen keyboard. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

IP 
Address/ 
Subnet 
Mask 

Set the IP address and the subnet mask that appear when 
[Machine IPv4 Address] in [Interface settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
addresses with the 10-key. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

Default 
Gateway 

Set the address that appears when [IPv4 Gateway Address] in 
[Interface Settings] tab is selected. 
For setting, enter the address with the 10-key. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

DNS 
Server 
1/DNS 
Server 
2/DNS 
Server 
3 

Set the server address that appears when [DNS Configuration] 
in [Interface Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
address with the 10-key. 

 

 

- 
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Item Detailed descriptions Default/Remarks 

Domain 
Name 

Set the name that appears when [Domain Name] in [Interface 
Settings] tab is selected. 
For setting, press [Specify] and [Change], and then enter the 
name with the screen keyboard. 

 

 

- 

 
2) Timer Setting 
* Setting from [System Settings] on [User Tools / Counter / Enquiry] screen of the device. 

 

Item Detailed descriptions Default/Remarks 

Auto 
Logout 
Timer 

The default value is [Off], however press [Auto Logout Timer] in 
[Timer Settings] tab and select [On] to enter the logout time if 
necessary to change it. 
The range of entering the automatic logout time is from 60 to 
999 seconds. 

Default: [Off] 
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Installation of VM Card 

 
 If the JavaVM is installed to the device’s Flash Memory (FM), this procedure is not 

necessary. In this case, please proceed to the “JavaVM Configuration”. 
 If JavaVM is not installed to the device, this procedure is not necessary. In this case, 

please proceed to the “IC Card Reader/Writer Connection (NFC R/W)”. 

1. Set [Auto Off Timer] to 5 minutes in [User Tools / Counter / Enquiry] screen  [System Settings]  
[Timer Settings] tab. 

 
 [Auto Off Timer] at the device side should be set to 5 minutes to prevent the device from 

entering the Auto Off mode while the Java TM Platform is installing or activating. 

2. Set [System Auto Reset Timer] to [Off] in [User Tools / Counter / Enquiry] screen  [System 

Settings]  [Timer Settings] tab. 

 
 This setting should be restored after the installation. 

3. Turn off the main power of the device. 
4. Insert the VM card into the SD card slot. 

 
 For which the SD card slot should be inserted into, see the service manual of each 

machine. 
5. Turn on the main power of the device. 

 
 The Java TM Platform is installed automatically if the main power of the device is turned on 

after the VM card insertion. 
 It takes for approx. 3 to 4 minutes to install it automatically. 
 Never turn off the power of the device during the installation, otherwise the VM card may 

be damaged. Turn off the power after the confirmation in step 8 has been done. 
6. Press [User Tools/Counter] button. 
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7. Press [Extended Feature Settings] in [User Tools / Counter / Enquiry] screen. 

 
8. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears after the 

installation is completed normally. 
 

JavaVM Configuration 

1. Press [User Tools/Counter] button. 
Press [Extended Feature Settings] after [User Tools / Counter / Enquiry] screen appears. 
2. Press [Extended Feature Settings]. 
3. Press [Administrator Tools] tab, and then press [Heap / Stack Size Settings]. 

 
Set the heap size and stack size.  

Model Heap size Stack size 
11S or earlier 16MB (Default: 10MB) 64KB (Default: 64KB) 
11A or later 48MB (Default: 16MB) Do not change from default size (Default: 256KB) 

 
4. Press the [Administrator Tools] tab, and then press [Select Available Functions]. 
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5. Set [PanelService API] as [Active]. 

 
6. Finish the initial settings. 
7. Push the power button at the side of the operation section. After the power indicator has finished 

blinking, turn off the main power. 

 
 The VM card should be operated with setting in the SD card slot. 
 Restore the original setting after installation if [System Auto Reset Timer] is changed. 

 

IC Card Reader/Writer Connection 

 
 The installation should be executed after the main power is turned off. 

 

 
 Connect the USB cable to the left USB port for Aficio MP C5000/C4000/C3300/C2800, Aficio 

MP C2550/C2050. 
 For other machines, either port can be connectable. 
 With Smart Operation Panel models, connect to the USB port of the device as with Standard 

Operation Panel models. 
 If your customer uses a NFC card reader, please refer to “IC Card Reader/Writer Connection 

(NFC R/W)” section for how to connect. 
 

IC Card Reader/Writer Connection (NFC R/W) 

 
NFC R/W can be used with 15S or later Smart Operation Panel models. 
 

1. Remove the cover at the right side of the Panel. 
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2. Connect a NFC R/W to the micro USB port. 

 
 

 

Authentication Management Settings 

1. Log in to the device as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
2. Press [User Tools/Counter] button, and then press [System Settings]. 

 
3. Press [Administrator Tools] tab, and set the items below. 

[Administrator Authentication Management] 
[User Authentication Management] 
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1) Administrator Authentication Management 
[User Management] 

 
1. Select [On] at [Admin. Authentication]. 
2. Press [Administrator Tools] at [Available Settings]. 
3. Press [OK] in the upper-right of the screen to enable the changes. 
[Machine Management] 

 
1. Select [On] at [Admin. Authentication]. 
2. Press the following items at [Available Settings]. 

[General Features]  [Tray Paper Settings]  [Timer Settings] 
[Interface Settings]  [File Transfer]  [Administrator Tools] 
[Maintenance] 

3. Press [OK] in the upper-right of the screen to enable the changes. 
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[Network Management] 

 
1. Select [On] at [Admin. Authentication]. 
2. Press the following items at [Available Settings]. 

[Interface Settings]  [File Transfer]  [Administrator Tools] 
3. Press [OK] in the upper-right of the screen to enable the changes. 
 
[File Management] 

 
1. Select [On] at [Admin. Authentication]. 
2. Press [Administrator Tools] at [Available Settings]. 
3. Press [OK] in the upper-right of the screen to enable the changes. 
 
  



 Technical Bulletin PAGE: 15/51 

Reissued: 16-Feb-18 

Model: Enhanced Locked Print NX v2 with CAP Date: 12-Mar-12 No.: RD602009p 
 

 

2) User Authentication Management 
1. Confirm whether the method of the authentication is “Custom” or “LDAP”*. 

* The displayed authentication type changes depending on a model. 

 
2. Select [Entire] at [Printer Job Authentication]. 

 
3. Select [None] at [Available Functions: Copier]. 

 
4. Select [None] at [Available Functions: Printer]. 
5. Cancel the following items at [Available Functions: Other Functions]. 

[Document Server]  [Facsimile]  [Scanner] 
[JavaTM/X]  

6. Press [OK] in the upper-right of the screen to enable the changes. 
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7. Turn off and on the main power, after the settings of [Administrator Authentication Management] 
and [User Authentication Management] are finished. 
 

With 15S or later Smart Operation Panel models, cancel the all items beside [Available Functions] (Do 
not follow Step 3-6 above). 

 

Installation of Enhanced Locked Print NX V2 with CAP 

Install the following applications using Remote Install Manager to install Enhanced Locked Print NX V2 
with CAP. For the installations procedures of these applications, see the service manual of Remote 

Install Manager. (  Remote Install Manager) 
 

 
 Regarding the installation method for Smart Operation Panel models (Compatibility mode), 

it is necessary to perform offline installation via RIM. It is not possible for the eDC-I system 
to judge which application module type (MP**: Compatibility mode / Z**: Hybrid mode) 
should be installed to devices equipped with the Smart Operation Panel. It is possible for 
Hybrid mode to perform online/offline installation via RIM. 
 

 
 In the case of Smart Operation Panel models (Hybrid mode), it is necessary to install 3 

modules for CAP before activation when conducting offline installation:  
 CAP V2 Z11 
 CAP User Config.*1 
 CAP NFC Plug-in *2 
*1 The CAP User Config. Tool is used only when the authentication type is Local DB or 
CAP-ES (Internal user). If the authentication type is AD, LDAP, or CAP-ES (only external 
user), it is not necessary to install the module for CAP User Config. Tool. 
*2 CAP NFC Plug-in is used for the card authentication between a NFC card reader and 
15S or later Smart Operation Panel models.    

 

 
 In the case of 12A models (MET-C1, CH-C1, OR-C2), before installing ELP-NX v2, make 

sure that at least one SD card slot located on the rear side of the device (option slot or 
service slot) is empty. For details, please also refer to the RTB “Enhanced Locked Print NX 
v2 Installation to 12A Models (MET-C1, CH-C1, OR-C2)”. Other models (11A or earlier and 
12A or later models) are not affected. 
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 If installing “ELP-NX with CAP (F12)” (Full Native mode), “Remote Install Manager v1.7.4” 

or later version is required. 
 

 
In the case of Standard Operation Panel and Smart Operation Panel (Compatibility mode): 

Application Version Note 

CAP V2 
MP11/MP21/MP31/SP31 

V2.x 

MP11 (WVGA models) 
MP21 (4-line LCD LP models) 
MP31 (12A or older 4.3-inch operation panel MFP models) 
SP31 (12S or later 4.3-inch operation panel LP models) 

ELP-NX V2 
MP11/MP12/MP13 
/MP31/SP31/MP33/SP13 
 

V2.x 

MP11 (12S or older WVGA models) 
MP12 (12A or later WVGA models) 
MP13(Only for Ricoh Asia Pacific. It needs to be installed 
offline. Target devices: Metis-C2 / Charis-C2 / Martini-C6 / 
Griffin-C2 / Corona-C1.5) 
MP31 (12A or older 4.3-inch operation panel MFP models) 
SP31 (12S or later 4.3-inch operation panel LP models) 
MP33 (15S or later 4.3-inch operation panel LP models) 
SP13 (15S or later 4-line LCD LP models) 

CAP LAUNCHER V2.x  

CAP V2.x  

ELP NX V2.x  

CAP REG V2.x  

FR Filter V1.x 08S or older models must install the FR Filter manually. 

 
In the case of Smart Operation Panel (Hybrid mode): 

Application Version Note 

CAP V2 Z11 V2.x  

ELP-NX V2 Z12 V2.x  

CAP V2.x  

ELP Service V2.x  

FR Filter V1.x  

ELP NX V1.x Smart Operation Panel application. 

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application. Only for v2.3.0 or later. 
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In the case of Smart Operation Panel (Full Native mode): 

Application Version Note 

ELP NX V1.x Smart Operation Panel application. 

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application.  

CAP Java Card Plug-in V1.x Smart Operation Panel application.  

 

Installation of FR Filter 

 
 Note that using Remote Install Manager will install the FR Filter automatically for 08A or 

later models. 
 When installing ELP-NX with CAP (F12), FR Filter is not installed but the function of “EGS” 

module in the controller is enabled.  

* SP mode (Special Service) “1-001-016”: bit6 [0]  [1] 
1. Press [User Tools/Counter] button. 
2. Press [Extended Feature Settings] in [User Tools / Counter / Enquiry] screen. 
3. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not activated yet. Wait for a 

while until [JavaTM Platform] appears. 
4. Press [Extended Feature Settings]. 
5. Press [Install] tab and then press [SD card]. 
6. Select [FR Filter] in the applications list. 
7. Select [Machine HDD] for the install location and press [Next]. 
8. Confirm the information on the screen and press [OK] to start the installation. 
9. Press [Exit] on the installation completion screen. 
10. Push the power button at the side of the operation section. After the power indicator has finished 

blinking, turn off the main power. 
  



 Technical Bulletin PAGE: 19/51 

Reissued: 16-Feb-18 

Model: Enhanced Locked Print NX v2 with CAP Date: 12-Mar-12 No.: RD602009p 
 

 

Activation Check 

1. After installing CAP v2 and ELP-NX v2 via Remote Install Manager, please wait 5 minutes before 
confirming the activation (step 3) because the start process is performed internally. 
 

2. In the case of CAP v2 (Hybrid mode), restart the device manually to enable authentication 
internally. 
 

3. Press [User Tools/Counter] button, and then press [Extended Feature Settings]. 

 

 
4. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not activated yet. Wait for a 

while until [JavaTM Platform] appears. 
5. Press [Extended Feature Settings]. 
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6. Confirm on [Startup Setting] tab that the condition of each application is the same as below: 
 
In the case of Standard Operation Panel and Smart Operation Panel (Compatibility mode): 

Application Status 

CAP V2 
MP11/MP21/MP31/SP31 

Starting Up 

ELP-NX V2 
MP11/MP12/MP31/SP31 

Starting Up 

CAP LAUNCHER 

Suspend 

 
The Launcher is disabled by default. Please set it as the 
“Priority” application to enable it. 
The Launcher is not supported on 4.3-inch operation 
panel models. 

CAP Starting Up 

ELP NX Suspend 

CAP REG Stop 

JavaTM Platform Starting Up 

FRFilter Waiting 

 
In the case of Smart Operation Panel (Hybrid mode): 

Application Status 

CAP V2 Z11 Starting Up 

ELP-NX V2 Z12 Starting Up 

CAP Starting Up 

ELP Service Starting Up 

JavaTM Platform Starting Up 

FR Filter Waiting 

 
In the case of Smart Operation Panel (Hybrid mode & Full Native mode), please also check 
whether the following applications are installed in User Tools  Screen Features  Screen Device 
Settings Information  Software Version List: 

Application Note 

ELP NX  

CAP V2 Auth. UI  

CAP User Config.  

CAP NFC plug-in Only for ELP-NX with CAP v2.3.0 or later. 
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In the case of Smart Operation Panel (Full Native mode): 

Application Note 

ELP NX  

CAP V2 Auth. UI  

CAP User Config.  

CAP NFC plug-in  

CAP Java Card Plug-in Only for ELP-NX with CAP v2.5.0 or later. 

 

 
The following SP modes are automatically set whenever the applications are started up (Every time 
when the machine power is turned on). In the case of Smart Operation Panel models, press the [x] 
button on the login screen and select the [Printer] icon after logging out, and then go in to SP 
mode. It is not possible to log in to SP mode from User Tools or Quick application (such as Quick 
Copy) and when logged into the device. 

 SP5-401-103: [0]  [3] 

 SP5-401-162*1: bit0 [0]  [1], bit3 [0]  [1] *2, bit5 [0]  [1] 

 SP5-401-230: bit0 [0]  [1], bit3 [0]  [1] *3 

 SP5-401-240: bit0 [0]  [1] 

 SP1-001-016: bit6 [0]  [1] * SP mode (Special Service)  
*1 The bit6 of SP5-401-162 is changed from [0] to [1] at the first time when an IC card is touched. 
However, this is a normal action. 
 The value of SP5-401-162 will not be changed by installing “ELP-NX with CAP (F12)” 
 
*2 It changes automatically when “Card Login Method” is set to “Enter Password from the Control 
Panel”. 
*3 It changes automatically when the Billing Code function is used. 
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[Standard Operation Panel model] Priority Feature Setting  

This setting is not required with Smart Operation Panel model. 
1. Press [User Tools/Counter] button, and then press [System Settings]. 

 
2. Press [General Features] tab, and then press [Function Priority]. 

 
3. Select [Java TM/X] and press [OK]. 
 

[Smart Operation Panel model] Specific settings 

Icon Setting (Only for 15S or later Smart Operation Panel models): 

ELP-NX and CAP User Config. Tools can be displayed on Home screen. 
1. Log in to the MFP as an Administrator. 
2. Press the square button on the right side of the panel. 
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3. Press and hold the ELP NX and CAP User Config.icon under [APPS] tab. This operation will locate 

the icon on Home Screen. 

 
4. ELP NX and CAP User Config. icons will appear. 

 
 

 

Icon Setting (Only for 15S or before Smart Operation Panel models): 

ELP-NX and CAP User Config. Tool can be displayed on Home screen. 
 
1. Log in to the MFP as an Administrator. 
2. Press and hold Home screen. The [Add to Home] screen will appear. 
3. Select [Icon]. 
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4. Select [Application]. 

 
5. Select [ELP NX]. If CAP User Config. Tool is installed, please also select [CAP User Config.]. 

 
6. ELP NX and CAP User Config. icons will appear. 
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Screen device always-connection Setting (15S or later models) 

1. Shift to Screen service mode.  

 
For information on how to enter Screen service mode, contact the supervisor in your branch office. 

2. Select [Screen Device Settings]. 
3. Enable [Screen device always-connection Setting]. 

 
 

Recommendation: Energy Saving Recovery for Business Application setting (15S or later 
models) 

If the setting is “On”, login or job list acquisition may be little slow at the first time after recovering the 
energy saving. We recommend setting this as “Off”. 
1. Log in to the MFP as an Administrator. 
2. Select [User Tools]. 
3. Select [Machine Features]. 
4. Select [System Settings]. 
5. Select [Energy Saving Recovry. for Business Applicatn.]. 

 
6. Set to [Off] and select [OK]. 
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Priority Feature Setting (For Compatibility / Hybrid mode): 

It is possible to select either CAP LAUNCHER (only for compatibility mode) or ELP NX as a default 
application when a user logs in to the device. 
 
How to configure Function Priority: 
1. Log in to the MFP as an Administrator. 
2. Select [Screen Features]. 

*With 15S or later models, select [User Tools] -> [Screen Features] 

  
3. Select [Screen Device Settings]. 

 
4. Select [Function Priority]. 
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5. In the case of Compatibility mode, select [ELP NX] or [CAP LAUNCHER]. In the case of Hybrid 
mode, select [ELP NX]. 

 
 
In the case of Compatibility mode: 

In the case of selecting CAP LAUNCHER for Function Priority: 
It is possible to register IC cards automatically. It is not possible to display the Job list screen 
directly after logging in. 
 
In the case of selecting ELP NX for Function Priority: 
It is not possible to register IC cards automatically. It is possible to display the Job list screen 
directly after logging in. To register an IC card, please use CAP REG. If CAP LAUNCHER is 
used, an authentication error will occur when an unregistered IC card is swiped.  

 
For details, please refer to the Technical Reference for CAP V2  Configuration.ppt  Appendix. 
GK FAQID:179654 [TR] CAP/ELP-NX/CAP-ES/ELP-NX FS V2: Top page (RAC RE RA RCN ) 

Authentication priority mode (For Hybrid mode / Full Native mode): 

When a device is in sleep mode, it takes more time for a user’s job list to be displayed after the user 
swipes their IC card on Smart Operation Panel models for Hybrid mode than it does on Standard 
Operation Panel models and Smart Operation Panel models (Compatibility mode). 
 
By setting the Authentication priority mode via the Screen service mode, the print job display for Hybrid 
mode is about as fast as the Standard Operation Panel models and Smart Operation Panel models 
(Compatibility mode). This setting means the HDD always starts within a designated time and it takes 
little time to authenticate the user information. However, this may negatively affect the TEC value (TEC 
= Typical Electricity Consumption). The procedure for setting it is as follows. 
1. Shift to Screen service mode.  

 
 For information on how to enter Screen service mode, contact the supervisor in your 

branch office. 
2. Select [Screen Device Settings]. 

 

http://tscweb.custhelp.com/app/answers/detail/a_id/180527
http://eu-tier2-en.custhelp.com/app/answers/detail/a_id/180528
http://ap-tier2-en.custhelp.com/app/answers/detail/a_id/180529
http://cn-tier2-en.custhelp.com/app/answers/detail/a_id/180530
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3. Select [Authentication priority mode]. 

 
4. Select [Start time(hhmm)] and enter the desired start time(hhmm). Also, select [Expiration 

time(hours)] and enter the desired expiration time(hours). It is possible to input the desired hour 
which is value of 1-10 hour(s). 
Their settings mean that it is time for Authentication priority mode to start and expire. 

 
5. Check [Authentication priority mode]. 

 
6. Logout. 
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Installation (4-line MFP/4-line LP/LP) 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Installation Environment Settings 

Set the following network information from system settings in the device. 
 Host Name 
 IP Address 
 Subnet Mask 
 Default Gateway 
 DNS Server 1 
 DNS Server 2 
 DNS Server 3 
 Domain Name 

Installation of VM Card 

1. Set [Energy Saver Timer] to 5 minutes in [User Tools / Counter / Enquiry] screen  [System 

Settings]  [Timer Settings] tab. 

 
 [Energy Saver Timer] at the device side should be set to 5 minutes to prevent the device 

from entering the Energy Saver mode while the Java TM Platform is installing or activating. 
2. Turn off the main power of the device. 
3. Insert the VM card into the SD card slot. 

 
 For which the SD card slot should be inserted into, see the service manual of each 

machine. 
4. Turn on the main power of the device. 

 
 The Java TM Platform is installed automatically if the main power of the device is turned on 

after the VM card insertion. 

The device network environment 

settings 

The VM Card Installation 

The Reader/writer connection for 

the IC Card 

The Installation environment setting 

Installation 

Priority feature setting 

1: Checking the version of the device firmware and the VM card 

2: Installation and activation of the applications 

3: Installation confirmation 
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 It takes for approx. 3 to 4 minutes to install it automatically. 
 Never turn off the power of the device during the installation, otherwise the VM card may 

be damaged. Turn off the power after the confirmation in step 9 has been done. 
5. Access to the device through Web Image Monitor. 
6. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
7. Click [Configuration] in the left menu. 

 
8. Click [Startup Setting] in [Extended Feature Settings] menu. 

 
9. Confirm that the status of [JavaTM Platform] is [Starting Up]. 
10. Click [Back]. 

 
11. Click [Administrator Tools] in [Extended Feature Settings] menu. 

 
12. Set [Heap Size] to 16 MB, [Stack Size] to 64 KB. 
13. Click [Apply]. 
14. Log out from Web Image Monitor. 
15. Select [Shutdown] from the menu of the device. 
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 Never turn off the power of the device before the shutdown, otherwise the HDD may be 

damaged. 
16. Turn off the main power. 

 
 The VM card should be operated with setting in the SD card slot. 

IC Card Reader/Writer Connection 

 
 The installation should be executed after the main power is turned off. 

Connect the IC card Reader/Writer to the device. 

Authentication Management Settings 

1. Open Web Image Monitor. 
2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Administrator Authentication Management] in [Device Settings] menu. 

 
5. Check [On] at the following items. 

[User Administrator Authentication] 
[Machine Administrator Authentication] 
[Network Administrator Authentication] 
[File Administrator Authentication] 

6. Click [OK] to enable the settings. 
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7. Click [User Authentication management] in [Device Settings] menu. 

 
8. Remove all check marks in [Available Function: Printer] of [LDAP Authentication Settings] or 

[Custom Authentication Settings]. 
9. Click [OK] to enable the settings. 
10. Log out from Web Image Monitor. 
11. Select [Shutdown] from the menu of the device. 
12. Turn off and on the main power. 

Installation of Enhanced Locked Print NX V2 with CAP 

Install the following applications using Remote Install Manager to install Enhanced Locked Print NX V2 
with CAP. 
 ELP-NX V2 MP21/SP11 
 ELP NX 
 FR Filter (08S or older models must install the FR Filter manually.) 
 CAP V2 MP21/SP11 
 CAP LAUNCHER 
 CAP 
 CAP REG 
For the installations procedures of these applications, see the service manual of Remote Install 

Manager. (  Remote Install Manager) 

Installation of FR Filter 

 
 Note that using Remote Install Manager will install the FR Filter automatically for 08A or 

later models. 
1. Open Web Image Monitor. 
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2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Install] in [Extended Feature Settings] menu. 

 
5. Check [SD Card Slot] and click [Display Extended Feature List]. 

 
6. Select [Device HDD] for the install location and check [FR Filter] in the list, and then click [Install]. 

 
7. Click [OK] on confirmation screen. 
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Installation Check 

1. After installing CAP v2 and ELP-NX v2 via Remote Install Manager, please wait 5 minutes before 
confirming the installation (next step) because the start process is performed internally. 

2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [Extended Feature Info] in [Extended Feature Settings] menu. 
5. In the lists on [Extended Feature Info] screen, confirm that each status of the application is as in the 

following. 

 

Application name Status 

CAP V2 MP21/SP11 Starting Up 

ELP-NX V2 MP21/SP11 Starting Up 

CAP Starting Up 

ELP NX Suspend 

CAP REG * Stop 

JavaTM Platform Starting Up 

FR Filter Waiting 

 
* Appears only in 4-line devices, when CAP REG has been installed. 

Priority Feature Setting 

1. Press [Maintenance]  [General Settings]  [Function Priority] from the menu of the device. 
2. Select [Java TM/X]. 

 
 The procedure of this setting differs from devices so that see the service manual of the device. 
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Installation (Pre-include model) 

18S or later models with Smart Operation Panel have CAP and ELP-NX installer in devices. 
CAP and ELP-NX can be installed to these models via Smart Operation Panel so Remote Install 
Manager is not required. 
 

Installation Flowchart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Installation Environment Settings 

“Please refer to “Installation Environment Settings” in “Installation (Smart Operation Panel/WVGA/ 
4.3-inch operation panel models)” section 
 

IC Card Reader/Writer Connection (NFC R/W) 

“Please refer to “IC Card Reader/Writer Connection (NFC R/W)” in “Installation (Smart Operation Panel/ 
WVGA/4.3-inch operation panel models)” section 
 

Authentication Management Settings 

“Please refer to “Authentication Management Settings” in “Installation (Smart Operation Panel/ 
WVGA/4.3-inch operation panel models)” section 
  

Installation environment settings 

The Reader/writer connection for 

the IC Card (NFC R/W) 

 

Authentication Management 

settings 

 

Smart Operation Panel model 

specific settings 

1: Checking the version of the device firmware  

2: Installation and activation of the applications 

3: Installation confirmation 

Installation 
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Installation of Enhanced Locked Print NX V2 with CAP 

The installation method of “ELP-NX” and “CAP” to 18S or later models with Smart Operation Panel 

models is as below. 

1) Display the legacy application on Cheetah’s operation panel, and login by operation SP 
mode. 

2) Choose “Device” > “Apps”. 
3) Choose “Install” 
4) Choose ”Install From Internal Storage” 
5) Install the following applications one by one (applications cannot be installed at the same 

time). 
 CAP V2 Auth.UI 
 CAP User Config. 
 CAP NFC Plug-in 
 CAP Java Card Plug-in 
 ELP NX 

Application installation is now completed.   
 
Next, activate the application. 
6) Return to the screen in the step 4, choose ”Activate Applications” 
7) Choose the following applications one by one, and input the product key and “Execute” for 

each. 
 CAP V2 Auth.UI 
 ELP NX 

8) After Activation is completed, restart the device. 

Activation Check 

“Please refer to Full Native mode of “Activation Check” in “Installation (Smart Operation 
Panel/WVGA/4.3-inch operation panel models)” section 
 

[Smart Operation Panel model] Specific settings 

“Please refer to “[Smart Operation Panel model] Specific settings” in “Installation (Smart Operation 
Panel/WVGA/4.3-inch operation panel models)” section 
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When Migrate to Card Authentication Package v2 from v1 

Migration from Card Authentication Package v1 to v2 requires the conversion of the user information 
from Card Authentication Package v1’s format to v2’s format. 
The following explains the conversion procedure using CAP Convert Tool. 

 
 For CAP Convert Tool, JRE v6.0 or later is required on the host PC. 

Conversion Flowchart 

 

Export the Data 

The following three files are required in order to convert the Card Authentication Package v1 data into 
v2 data. 
 Card information file: card(date).csv 
 User information file: (model name)_user.csv 
 Address information file: (model name)_addr.csv 
These exports have to be done before uninstalling v1. 
 
1) Export the card information 
1. Click [Maintenance] to show [Card ID Mapping Maintenance] screen. 

 
2. Click [Export]. 
The export operation creates a CSV file containing the card information. 
Example: cardmmdd.csv (mmdd: an exported month (mm) and day (dd)) 
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2) Export the user information 

 
1. Launch [User Management Tool] of Smart Device Monitor for Admin. 

 
2. Select [Access Control List] tab. 

 
3. Select [Export User Information] from [File] menu. 
The user information is exported as a CSV file. 
Example (for an Aficio MP C5000): Aficio_MP_C5000_user.csv 
3) Export the address information 

 
1. Launch [Address Management Tool] of Smart Device Monitor for Admin. 
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2. Select [Export Data] from [File] menu. 
Three CSV files are created by the export process and one of them is needed for the conversion. 
Example (for an Aficio MP C5000): 
Aficio_MP_C5000_faxinfo.csv 
Aficio_MP_C5000_taginfo.csv 
Aficio_MP_C5000_addr.csv (Only this file is needed for the conversion.) 

Uninstall Card Authentication Package v1 

For the Card Authentication Package v1 uninstallation, see the service manual for Card Authentication 

Package v1. (  Card Authentication Package v1 Service Manual) 

Install Card Authentication Package v2 

For the Card Authentication Package v2 installation, install it with Remote Install Manager. See the 

service manual of Remote Install Manager. (  Remote Install Manager) 

Convert the Data Format 

3. Before running CAP Convert Tool, put the tool and the files into the same directory. 
 CAP Convert Tool: DataConvertFromCap.exe 
 Card information file: card(date).csv 
 User information file: (model name)_user.csv 
 Address information file: (model name)_addr.csv 

4. CAP Convert Tool is a command-line tool. Open a command prompt and switch to the directory 
where the files are located. 

5. Enter the following command. 
DataConvertFromCap.exe (User information file name) (Address information file name) (Card 
information file name) [Character-code] 

 
 If any character code is not specified, “Cp1252” will be used as a default. 
 For a list of supported character encoding types, refer to the 2nd column of the following 

list: 
 http://download.oracle.com/javase/1.5.0/docs/guide/intl/encoding.doc.html 

6. A message is displayed when the conversion is complete. The message includes the following 
information: 
 User information registered (total item) 
 Convert user information items (succeeded) 
 Input format error items (failed) 
 Conversion error items (failed) 
If there is no error, close the command prompt. 



 Technical Bulletin PAGE: 40/51 

Reissued: 16-Feb-18 

Model: Enhanced Locked Print NX v2 with CAP Date: 12-Mar-12 No.: RD602009p 
 

 

Import the Data 

A successful conversion creates the following two files: 
 DataConvertFromCap.csv 

This is the user information file for Card Authentication Package v2. 
To import the data, use CAP v2 Configuration Tool. 

 DataConvertFromCap.log 
This log contains the conversion results and the error information. 
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Uninstallation 

Uninstallation 

Uninstallation (Smart Operation Panel/WVGA/4.3-inch operation panel models) 

 Depending on the device model, the actual operation panel screen may look different from the 
screenshots used in this document. 

 

[Smart Operation Panel model] Specific settings (Hybrid mode / Full Native mode) 

Set “Authentication Priority mode (Hybrid mode / Full Native mode)” via the Screen service mode to off. 
 
1. Shift to Screen service mode.  

 
 For information on how to enter Screen service mode, contact the supervisor in your 

branch office. 
2. Select [Screen Device Settings]. 

 
 
3. Select [Authentication priority mode]. 
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4. Clear the check box for [Authentication priority mode]. 

 
 
5. Logout. 
 

Setting in the Device 

1. Log in the device as an administrator. 
2. Set [Enhanced Authentication Management]* to [Off]. 

*[System Settings]->[Administrator Tools]->[Enhanced Authentication management] 

 
 The SC636 error will occur when ignoring the process above. 

Priority Feature Cancellation 

In the case of Standard Operation Panel models: 
1. Press the [User Tools/Counter] button. Then, press [System Settings]. 
2. Select the [General Features] tab. Then, press [Function Priority]. 
3. Select any item on the screen other than [Java TM/X] and press [OK]. 
 

In the case of Smart Operation Panel models: 
1. Press the [Screen Features] button. Then, press [System Settings]. 

*With 15S or later models, select [User Tools] -> [Screen Features]  
2. Press [Function Priority]. 
3. Select any item on the screen other than [ELP NX]. 

Authentication Management Settings 

1. Log in the device as an administrator. 

 
 The initial value of login data is as follows: 
 Login user name: admin 
 Password: [blank] 

2. Press [User Tools/Counter] button, and then press [System Settings]. 
*With 15S or later models, select [User Tools] -> [Machine Features] -> [System Settings] 
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3. Press [Administrator Tools] tab, and set items below: 
[User Authentication Management] 
[Administrator Authentication Management] 

 
1) User Authentication Management 

1. Set the method of the authentication is “Off”. 
2. Press [OK] of the upper right. 

2) Administrator Authentication Management 
[User management] 
1. Set [Admin. Authentication] to [Off]. 
 [Machine Management] 
2. Set [Admin. Authentication] to [Off]. 
 [Network Management] 
3. Set [Admin. Authentication] to [Off]. 
 [File Management] 
4. Set [Admin. Authentication] to [Off]. 
5. Press [OK] of the upper right. 

How to stop applications 

With Smart Operation Panel models (Hybrid mode): 
1. Login to the device as an administrator. 
2. Choose [User Tools] -> [Machine Features] -> [System Settings] -> [Extended Feature Settings] -> 

[Extended Feature Settings]. 
3. Choose [Startup Setting] tab, and press following applications one by one: 

 CAP V2 Z11 
 ELP-NX V2 Z12 
 CAP 
 ELP Service 
 FR Filter 
 

 Press [CAP V2 Z11], then the application will be stopped. 
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4. Choose [Extended Feature Info] tab. 
5. Press an application name. 

 
6. Set [Auto Start] to "Off". Then press [Exit]. 

 
7. Conduct the same procedure for the following applications as well: 

 CAP V2 Z11 
 ELP-NX V2 Z12 
 CAP 
 ELP Service 
 

Turn the power off and on after the settings are completed. 
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Uninstallation of Enhanced Locked Print NX V2 with CAP 

Uninstall the following applications using Remote Install Manager to uninstall Enhanced Locked Print 
NX V2 with CAP. For the uninstallations procedures of these applications, see the service manual of 

Remote Install Manager. (  Remote Install Manager) 
 
In the case of Standard Operation Panel models and Smart Operation Panel models (Compatibility 
mode): 
 ELP-NX V2 MP11/MP12/MP13/MP31/ MP33/SP31 
 ELP NX 
 FR Filter (08S or older models must uninstall the FR Filter manually.) 
 CAP V2 MP11/MP21/MP31/SP31 
 CAP LAUNCHER 
 CAP 
 CAP REG 
 
In the case of Smart Operation Panel models (Hybrid mode): 

Application Version Note 

CAP V2 Z11 V2.x  

ELP-NX V2 Z12 V2.x  

CAP V2.x  

ELP Service V2.x  

FR Filter V1.x  

ELP NX V1.x Smart Operation Panel application. 

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application. Only for v2.3.0 or later. 

 
In the case of Smart Operation Panel models (Full Native mode): 

Application Version Note 

ELP NX V1.x Smart Operation Panel application. 

CAP V2 Auth. UI V1.x Smart Operation Panel application. 

CAP User Config. V1.x Smart Operation Panel application. 

CAP NFC Plug-in V1.x Smart Operation Panel application.  

CAP Java Card Plug-in V1.x Smart Operation Panel application. Only for v2.5.0 or later. 

 

 
If “RTY-003 : Communication timeout has occurred between the devices. (N002)” is displayed on 
Remote Install Manager after uninstallation, please try to restart the device manually and perform 
[Re-execute Errored Operation...] from the Device Operation menu. If the error still appears even 
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though the operation is performed, check the error for troubleshooting in Remote Install Manager 
Service Manual. 

 

Uninstallation of FR Filter 

 
 Note that using Remote Install Manager will uninstall the FR Filter automatically for 08A or 

later models. 
 When uninstall “ELP-NX with CAP (F12)”, this procedure is not necessary. 

1. Press [User Tools/Counter] button. 
2. Press [Extended Feature Settings]. 
3. Confirm on [Extended Feature Setting Menu] screen that [JavaTM Platform] appears. 

 
 If [JavaTM Platform] is not shown, the Java TM Platform has not activated yet. Wait for a 

while until [JavaTM Platform] appears. 
4. Press [Extended Feature Settings]. 
5. Press [Uninstall] tab and then select [FR Filter] in the applications list. 
6. Press [Yes]. 
7. Press [Yes]. 
8. Press [Exit]. 
9. Push the power button at the side of the operation section. After the power indicator has finished 

blinking, turn off the main power. 
10. Turn on the main power. 
11. Press [User Tools/Counter] button. 
12. Press [Extended Feature Settings] on [User Tools / Counter / Enquiry] screen. 
13. Press [Extended Feature Settings] on [Extended Feature Setting Menu] screen. 
14. Press [Uninstall] tab. 
15. Confirm that [FR Filter] is not shown in the applications list. 

 
 The main power should be turned off and on after the uninstallation. Otherwise the application 

may be reinstalled incorrectly. 

SP Mode Cancellation 

Restore the SP values described below. In the case of Smart Operation Panel models, press the [x] 
button on the login screen and select the [Printer] icon after logging out, and then go in to SP mode. It is 
not possible to log in to SP mode from User Tools or Quick application (such as Quick Copy) and when 
logged into the device. 

 SP5-401-103: [3]  [0] 

 SP5-401-162: bit0 [1]  [0], bit3 [1]  [0], bit5 [1]  [0], bit6 [1]  [0] 

 SP5-401-230: bit0 [1]  [0], bit3 [1]  [0] 

 SP5-401-240: bit0 [1]  [0] 

 SP1-001-016 bit6 [1]  [0] *SP mode (Special Service) 

 
 The machine should be rebooted after the settings are changed. 
 The setting changes are not necessary if the reinstallation is executed. 
 Depending on the functions the customer uses, not all of the above SP values may be set 

to [1] even before cancelling them. 
 The value of SP5-401-162 will not be changed by installing “ELP-NX with CAP (F12)” 
 If SP1-101-016 bit6 remains [1], print jobs will still be stored in device even after 

uninstalling ELP. 
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Uninstallation (4-line MFP/4-line LP/LP) 

Setting in the Device 

Set [Enhanced Authentication Management] in [Security Management] to [Off]. 

 
 The SC636 error will occur when ignoring the process above. 

Setting from Web Image Monitor 

1. Open Web Image Monitor. 
2. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
3. Click [Configuration] in the left menu. 

 
4. Click [User Authentication Management] in [Device Settings] menu. 

 
5. Select [Off] at [User Authentication Management] and click [OK]. 

 
6. Click [Administrator Authentication Management] in [Device Settings] menu. 
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7. Check [Off] at the following items and click [OK]. 

 [User Administrator Authentication] 
 [Machine Administrator Authentication] 
 [Network Administrator Authentication] 
 [File Administrator Authentication] 

8. Turn off and on the main power. 
9. Uninstall the following applications using Remote Install Manager to uninstall CAP. 

 CAP V2 MP21/SP11 
 CAP LAUNCHER 
 CAP 
 CAP REG 
For the uninstallation procedures of these applications, see the service manual of Remote Install 

Manager. (  Remote Install Manager) 

 
 The following procedures (steps 10 through 15) are needed for 08S or older models. 

10. Open Web Image Monitor. 
11. Log in to Web Image Monitor as an administrator. 

 
 The initial value of login is as follows: 
 Login user name: admin 
 Password: [blank] 

 
12. Click [Configuration] in the left menu. 

 
13. Click [Uninstall] in [Extended Feature Settings] menu. 
14. Select [FR Filter] in the applications list. 
15. Reboot the device. 
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SP Mode Cancellation 

Restore the SP values described below. 

 SP5-401-103: [3]  [0] 

 SP5-401-162: bit0 [1]  [0], bit5 [1]  [0] 

 SP5-401-230: bit0 [1]  [0] 

 SP5-401-240: bit0 [1]  [0] 

 
 The machine should be rebooted after the settings are changed. 
 The setting changes are not necessary if the reinstallation is executed after the uninstallation. 

Priority Feature Cancellation 

1. Press [Maintenance]  [General Settings]  [Function Priority] from the menu of the device. 
2. Select an item on the screen other than [Java TM/X]. 

 
 The procedure of this setting differs from devices so that see the service manual of the device. 
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Appendix 

VM Card Update 

 
 The steps below should be followed when updating the VM card if ELP-NX v2 and CAPv2 

are installed. 
 

1. Disable Enhanced Authentication Management (SP5-401-160: [1]  [0]). 

 
 Proceed to step 2 without rebooting the device. 

2. Update the VM card using Remote Install Manager.  
3. Reboot the device two times (some settings are automatically set during the 1st reboot that require 

a 2nd reboot to enable). 
 

Procedure for changing the HDD 

 
1. Export the user/device settings via the Configuration Tool for back up. (If possible) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all the applications (CAP and ELP-NX) using Remote Install Manager. 
3. Change out the HDD. 

 
 Please refer to the device service manual to change out the HDD. 

 

4. Reinstall all the applications (CAP and ELP-NX) using Remote Install Manager. 
5. Import the user/device setting in Configuration Tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 

 
 

Procedure for changing the controller board 

This procedure is available in the case that Java VM is installed to the device’s flash memory (FM) on 
the controller board. 
 
1. Export the user/device settings via the Configuration Tool for back up. (If possible.) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all applications (CAP and ELP-NX) via Remote Install Manager. 

 
 In the case that the controller board needs to be replaced when using Hybrid mode: 

If it is necessary to replace the controller board, the Smart Operation Panel applications 
will remain. Therefore, the applications should be uninstalled using RIM. 
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3. Disable the Java VM (SP5-730-001: [1] -> [0]). Then restart the device. 
4. Change out the controller board. 

 
 Please refer to the device service manual to change out the Controller Board. 

 

5. Reinstall all the applications (CAP and ELP-NX) using Remote Install Manager. 
6. Import the user/device setting in configuration tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 

 
 

Procedure for changing the Smart Operation Panel  

This procedure is available when changing to a Smart Operation Panel from a Standard Operation 
Panel or if a Smart Operation Panel needs to be replaced. 
 
1. Export the user/device settings via the Configuration Tool for back up. (If possible.) 

File --> Export --> Select User Information and Device Settings for export --> Click the "Export" 
button. 

2. Uninstall all applications (CAP and ELP-NX) via Remote Install Manager.  

 
 In the case that the Smart Operation Panel needs to be replaced when using Hybrid mode: 

If it is necessary to replace the Smart Operation Panel, the DSDK applications installed 
in the Java VM will remain. Therefore, these applications should be uninstalled via Web 
image Monitor. The uninstallation method via Web Image Monitor is as follows. 

WIM -> Configuration -> “Uninstall” in Extended Feature Settings 
 

 The reason for why the DSDK applications must be uninstalled via WIM is as follows: 
As per the specification for the eDC-i system, the DSDK applications installed in the 
Java VM and the Smart Operation Panel applications are regarded as 1 application. 
When the Smart Operation Panel is replaced (the DSDK applications are left and the 
Smart Operation Panel applications disappear), the eDC-i system will judge that both 
the DSDK applications and the Smart Operation Panel applications are deleted. This 
will cause an error to occur when uninstalling via RIM. Therefore, it is necessary to 
uninstall the remaining DSDK applications via WIM in order to clear the error in RIM. 
 

 In the case that the Smart Operation Panel needs to be replaced when using Hybrid mode: 
It is necessary to forcibly deactivate the license key in advance. Please contact the 
marketing section in your branch office regarding the deactivation method. 
 

3. Reinstall all applications (CAP and ELP-NX). 
4. Import the user/device settings via the Configuration Tool. 

File --> Import --> Browse for the User Information and Device Settings --> Click the "Import" 
button. 
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Summary 

When installing Card Authentication Package v2 (CAP v2) / Enhanced Locked Print NX v2 (ELP-
NX v2) on some 11A models, certain actions must be performed in order to ensure correct 
operation. 

1. Only the CAP v2 / ELP-NX v2 versions listed below may be installed on the current 11A models
(AT-C3, AP-C3, AL-C2):
- CAP v2.1.0 or later
- ELP-NX v2.1.1 or later

2. Because the standard Java VM for 11A models contains some bugs known to affect CAP v2 /
ELP-NX v2, the Java VM must be upgraded before CAP v2 / ELP-NX v2 installation.

3. Since CAP v2 may fail to obtain the login user name from device address book, the firmware for
System/Copy must be upgraded before CAP v2 / ELP-NX v2 installation.

4. Disabling the device’s STR mode (turn SP5-191-001 to 0) is recommended because of the
current device limitation described in section 4 below.

1. 11A Model Support and PC application Version Compatibility:

Following chart shows the compatibility between modules/versions.
- “Compatibility” indicates a supported combination of Server module and Embedded module.
- “11A Model Support” indicates whether AT-C3, AP-C3 and AL-C2 are supported or not. Note that
S-C5 and GR-C1 are not included.

Embedded Module (SDK application) 

V1.3 series V1.4 series V2.0 series V2.1 series 

Server 
Module 
(PC 
application) 

V2.1 
series 

Compatibility : 
YES 

11A Support: NO

Compatibility : 
YES 

11A Support: NO

Compatibility : 
YES 

11A Support: NO 

Compatibility : YES
11A Support: YES 
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2. Required Java VM Version: 

Model Version Program No. Effective Date 
AT-C3 10.04.02 D1445594E April 2012 production 
AP-C3 10.04.02 D1445594E April 2012 production 
AL-C2 10.04.02 D1295735D April 2012 production 

Note: The same UpdateTool module can be used even though the Program No. is different. 
 
CAP v2 / ELP-NX v2: 
- Update Device’s JavaVM using Remote Install Manager. Update is automatically performed 

when the CAP v2 / ELP-NX v2 is installed. No specific action is required. 
 

3. Required System/Copy Version: 

Model Version Program No. Effective Date 
AT-C3 2.00.3 D1425562H March 2012 production 
AP-C3 2.00.3 D1445562H March 2012 production 
AL-C2 2.00.3 D1295751F March 2012 production 

 

4. 11A models don't reply to network requests for SDK applications. 

Occurrence Condition: 
If a SDK application has a Web UI, it cannot be accessed from a web browser once the device 
enters STR mode. Also, remote configuration from the administration tool is impossible. This is 
known to affect: 
- CAP v2 / ELP-NX v2 configuration from the Web Configuration Tool. 
 
Workaround (either): 
- Disable STR mode. 
- Retry the operation (as the first network request to the SDK application wakes the device up 
from STR mode, the second attempt will succeed).  
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This RTB has been issued to announce the firmware release information for the  

CAP User Config for eDC. 

 

Version Program No. Effective Date 
1.4.000 D60210JAD_forEDC February 2017 production 
1.3.000 D60210JAC_forEDC June 2016 production 
1.2.600 D60210JAB_forEDC August 2015 production 
1.2.5 D60210JAA_forEDC December 2014 production 
1.2.4 D60210JA_forEDC Initial release 

 

Version Modified Points or Symptom Corrected 

1.4.000 Support: 
Support for the following models has been added: 

- MET-C2z 

- CH-C2 Office 

- CH-C2 Pro (Only Smart Operation Panel option mounted device) 

- Cor-C1.5 

- GR-C3 

1.3.000 Supported: 
Support for the following 15S model has been added: 
- MET-C2 

1.2.600 Support: 
Support for the following 15S model (Hybrid mode) has been added: 

- GR-C2 

1.2.5 Support: 
Support for the following 14S Smart Operation Panel model (Hybrid mode) has 
been added: 
- Cor-C1 c, d, e, f, g, h 

1.2.4 Initial Release. 
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Summary 

When a device is in sleep mode, it takes more time for a user’s job list to be displayed 
after the user swipes their IC card on Smart Operation Panel models for Hybrid mode than 
it does on Standard Operation Panel models and Smart Operation Panel models 
(Compatibility mode).  
 
After installing Enhanced Locked Print NX v2 with CAP for Hybrid mode, a certain action must be 

performed. The Authentication priority mode must be set via the Screen service mode. By setting 
the Authentication priority mode, the print job display for Hybrid mode is about as fast as 
the Standard Operation Panel models and Smart Operation Panel models (Compatibility 
mode). This setting means the HDD always starts within a designated time and it takes a 
little time to authenticate the user information. However, this may negatively affect the TEC 
value (TEC = Typical Electricity Consumption). 
 

How to install ELP-NX v2 with CAP and set “Authentication priority mode” in Hybrid 
mode. 

1. Install ELP-NX v2 and CAP v2 using Remote Install Manager. For details, please refer to the 
Installation Manual for ELP-NX v2 with CAP. 

2. Set the Authentication priority mode for Hybrid mode via the Screen service mode. For details, 
please refer to “Authentication Priority mode (For Hybrid mode)” in the Installation Manual for 
ELP-NX v2 with CAP. 
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This RTB has been issued to announce the firmware release information for the  

ELP-NX FS V2 for RA. 

 

 

 

 

Version Modified Points or Symptom Corrected 

2.4.000.0 Support: 

- Windows Server 2016/MacOS X 10.12 is supported. 

- SQL Server 2016 is supported. 

- Windows Server 2003/2003 R2/Windows 8 are excluded as support 
environments. 

 
Fixed: 

- If using My Document Folders and the authentication mode on the 
device is set to user code authentication, users cannot print. 

- After changing the DB Server Name/Database Name in the Database 
Management Tool, they cannot be returned to the value set before the 
change. 

- ELP-NX FS may not work correctly after an update installation. 
 
Other: 

- Activation method has been changed from server license to client 
access license (CAL). 

A fix for a vulnerability regarding Click Jacking has been added. 

2.3.101.0 Fixed: 
When using multiple LF servers, the print job may not be displayed in the job list. 

2.3.100.0 Support: 
1. Support for TLS1.2 has been added. 

Version Program No. Effective Date 

2.4.000.0 D602-0078P February 2017 production 
2.3.101.0 D6020078N October 2016 production 
2.3.100.0 D6020078M September 2016 production 
2.3.000.0 D6020078L June 2016 production 
2.2.503.0 D6020078K September 2015 production 
2.2.502.0 D6020078J July 2015 production 
2.2.501.0 D6020078H Initial release 
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Version Modified Points or Symptom Corrected 

*The Java VM version on the device must support TLS1.2. 
2. Support for SHA-2 has been added. 

*The Java VM version on the device must support SHA-2. 
 
Other: 
1. Paper size is displayed for each print job. 
2. RSInfo has been updated. 
3. A fix for the Apache Commons Collection (ACC) vulnerability has been 

added. 

2.3.000.0 Supported: 
1. Support for Fire Fox ESR 38 has been added. 
2. Citrix XenApp 7.5 and 7.6 are supported. 
 
Fix: 
1. Cannot print small file size PS jobs that are spooled in ELP-NX FS. 
2. If 2 byte character is set as FRPRINT port, job list cannot be obtained from 

ELP-NX FS. 
 
Other: 
1. Primary and Secondary CAP-ES servers can be specified in ELP-NX FS 

Web UI. 
2. Activation site has been changed from GMP server to eDC-i server. 
3. Java version has been updated to 8. 

2.2.503.0 Fixed: 

- Fails to display the print job preview if "Do not Prepare" is set for the 
"Preview Create" setting in ELP-NX FS v2. 

- A job from Mac client via LPR may not be spooled. 

2.2.502.0 Support: 
None. 
 
Fixed: 
None. 
 
Other: 
- Preview settings (enable/disable the preview function, preview image 

creation timing, etc.) have been added. 

2.2.501.0 Fixed: 
1. CPU usage rates become high when multiple print jobs are spooled on the 

ELP-NX FS server at the same time. Because in v2.2.4 and 2.2.5, preview 
data is created when spooling the jobs on ELP-NX FS and up to 3 previews 
are created at the same time. To avoid this, there are 2 modifications in 
v2.2.501. 
- Preview data is created when selecting the preview button on a device. 
- Only 1 preview is created during the creation process. 
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This RTB has been issued to announce the firmware release information for the 

ELP-NX FS V2 for RKR. 

Version Modified Points or Symptom Corrected 

2.4.000.0 Support: 

- Windows Server 2016/MacOS X 10.12 is supported.

- SQL Server 2016 is supported.

- Windows Server 2003/2003 R2/Windows 8 are excluded as support
environments.

Fixed: 

- If using My Document Folders and the authentication mode on the
device is set to user code authentication, users cannot print.

- After changing the DB Server Name/Database Name in the Database
Management Tool, they cannot be returned to the value set before the
change.

- ELP-NX FS may not work correctly after an update installation.

Other: 

- Activation method has been changed from server license to client
access license (CAL).

- A fix for a vulnerability regarding Click Jacking has been added.

2.2.3.0 Fixed: 
1. CPU usage rates become high when multiple print jobs are spooled on the

ELP-NX FS server at the same time. Because in v2.2.4 and 2.2.5, preview
data is created when spooling the jobs on ELP-NX FS and up to 3 previews
are created at the same time. To avoid this, there are 2 modifications in
v2.2.501.
- Preview data is created when selecting the preview button on a device.
- Only 1 preview is created during the creation process.

Version Program No. Effective Date 

2.4.000.0 D602-00A8P February 2017 production 
2.2.3.0 D60200A8 Initial release 
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This RTB has been issued to announce the firmware release information for the  

ELP-NX FS V2 for RAC. 

 

 

 

 

Version Modified Points or Symptom Corrected 

2.4.000.0 Support: 

- Windows Server 2016/MacOS X 10.12 is supported. 

- SQL Server 2016 is supported. 

- Windows Server 2003/2003 R2/Windows 8 are excluded as support 
environments. 

 
Fixed: 

- If using My Document Folders and the authentication mode on the 
device is set to user code authentication, users cannot print. 

- After changing the DB Server Name/Database Name in the Database 
Management Tool, they cannot be returned to the value set before the 
change. 

- ELP-NX FS may not work correctly after an update installation. 
 
Other: 

- Activation method has been changed from server license to client 
access license (CAL). 

- A fix for a vulnerability regarding Click Jacking has been added. 

2.3.101.0 Fixed: 
When using multiple LF servers, the print job may not be displayed in the job list. 

2.3.100.0 Support: 
1. Support for TLS1.2 has been added. 

Version Program No. Effective Date 

2.4.000.0 D6020088P February 2017 production 
2.3.101.0 D6020088N October 2016 production 
2.3.100.0 D6020088M September 2016 production 
2.3.000.0 D6020088L June 2016 production 
2.2.503.0 D6020088K September 2015 production 
2.2.502.0 D6020088J July 2015 production 
2.2.501.0 D6020088H Initial release 



 Technical Bulletin PAGE: 2/2 

Reissued: 06-Feb-17 

Model: Gloria Date: 08-Apr-15 No.: RD602023f 
 

 

Version Modified Points or Symptom Corrected 

*The Java VM version on the device must support TLS1.2. 
2. Support for SHA-2 has been added. 

*The Java VM version on the device must support SHA-2. 
 
Other: 
1. Paper size is displayed for each print job. 
2. RSInfo has been updated. 
3. A fix for the Apache Commons Collection (ACC) vulnerability has been added. 

2.3.000.0 Supported: 
1. Support for Fire Fox ESR 38 has been added. 
2. Citrix XenApp 7.5 and 7.6 are supported. 
 
Fix: 
1. Cannot print small file size PS jobs that are spooled in ELP-NX FS. 
2. If 2 byte character is set as FRPRINT port, job list cannot be obtained from 

ELP-NX FS. 
 
Other: 
1. Primary and Secondary CAP-ES servers can be specified in ELP-NX FS 

Web UI. 
2. Activation site has been changed from GMP server to eDC-i server. 
3. Java version has been updated to 8. 

2.2.503.0 Fixed: 

- Fails to display the print job preview if "Do not Prepare" is set for the 
"Preview Create" setting in ELP-NX FS v2. 

- A job from Mac client via LPR may not be spooled. 

2.2.502.0 Support: 
None. 
 
Fixed: 
None. 
 
Other: 
- Preview settings (enable/disable the preview function, preview image 

creation timing, etc.) have been added. 

2.2.501.0 Fixed: 
1. CPU usage rates become high when multiple print jobs are spooled on the 

ELP-NX FS server at the same time. Because in v2.2.4 and 2.2.5, preview 
data is created when spooling the jobs on ELP-NX FS and up to 3 previews 
are created at the same time. To avoid this, there are 2 modifications in 
v2.2.501. 
- Preview data is created when selecting the preview button on a 

device. 
- Only 1 preview is created during the creation process. 
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This RTB has been issued to announce the firmware release information for the  

ELP-NX FS V2 for RE. 

 

 

 

 

Version Modified Points or Symptom Corrected 

2.4.000.0 Support: 

- Windows Server 2016/MacOS X 10.12 is supported. 

- SQL Server 2016 is supported. 

- Windows Server 2003/2003 R2/Windows 8 are excluded as support 
environments. 

 
Fixed: 

- If using My Document Folders and the authentication mode on the 
device is set to user code authentication, users cannot print. 

- After changing the DB Server Name/Database Name in the Database 
Management Tool, they cannot be returned to the value set before the 
change. 

- ELP-NX FS may not work correctly after an update installation. 
 
Other: 

- Activation method has been changed from server license to client 
access license (CAL). 

A fix for a vulnerability regarding Click Jacking has been added. 

2.3.101.0 Fixed: 
When using multiple LF servers, the print job may not be displayed in the job list. 

2.3.100.0 Support: 
1. Support for TLS1.2 has been added. 

Version Program No. Effective Date 

2.4.000.0 D6020068P February 2017 production 
2.3.101.0 D6020068N October 2016 production 
2.3.100.0 D6020068M September 2016 production 
2.3.000.0 D6020068L June 2016 production 
2.2.503.0 D6020068K September 2015 production 
2.2.502.0 D6020068J July 2015 production 
2.2.501.0 D6020068H Initial release 
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Version Modified Points or Symptom Corrected 

*The Java VM version on the device must support TLS1.2. 
2. Support for SHA-2 has been added. 

*The Java VM version on the device must support SHA-2. 
 
Other: 
1. Paper size is displayed for each print job. 
2. RSInfo has been updated. 
3. A fix for the Apache Commons Collection (ACC) vulnerability has been added.  
 

2.3.000.0 Supported: 
1. Support for Fire Fox ESR 38 has been added. 
2. Citrix XenApp 7.5 and 7.6 are supported. 
 
Fix: 
1. Cannot print small file size PS jobs that are spooled in ELP-NX FS. 
2. If 2 byte character is set as FRPRINT port, job list cannot be obtained from 

ELP-NX FS. 
 
Other: 
1. Primary and Secondary CAP-ES servers can be specified in ELP-NX FS 

Web UI. 
2. Activation site has been changed from GMP server to eDC-i server. 
3. Java version has been updated to 8. 

2.2.503.0 Fixed: 

- Fails to display the print job preview if "Do not Prepare" is set for the 
"Preview Create" setting in ELP-NX FS v2. 

- A job from Mac client via LPR may not be spooled. 

2.2.502.0 Support: 
None. 
 
Fixed: 
None. 
 
Other: 
- Preview settings (enable/disable the preview function, preview image 

creation timing, etc.) have been added. 

2.2.501.0 Fixed: 
1. CPU usage rates become high when multiple print jobs are spooled on the 

ELP-NX FS server at the same time. Because in v2.2.4 and 2.2.5, preview 
data is created when spooling the jobs on ELP-NX FS and up to 3 previews 
are created at the same time. To avoid this, there are 2 modifications in 
v2.2.501. 
- Preview data is created when selecting the preview button on a device. 
- Only 1 preview is created during the creation process. 
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This RTB has been issued to announce the firmware release information for the 

CAP NFC Plugin for eDC. 

Version Program No. Effective Date 
1.4.000 D60210MBB_forEDC February 2017 production 
1.3.100 D60210MBA_forEDC August 2016 production 
1.3.000 D60210MB_forEDC Initial release 

Version Modified Points or Symptom Corrected 

1.4.000 Support: 

- Support for the following models has been added:
MET-C2z
CH-C2 Office
CH-C2 Pro (Only Smart Operation Panel option mounted device)
Cor-C1.5
GR-C3

1.3.100 Supported: 
1. Support for the following 15S model has been added:

- Lef-C1, Brz-MF1
2. Support for the following 16S model has been added:

- MT-C6, Gim-MF1.5dM

Others: 
1. Support for Felica security in NFC card readers has been added.

1.3.000 Initial Release. 
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This RTB has been issued to announce the firmware release information for the 

ELP NX V2_MP13 for eDC. 

Version Modified Points or Symptom Corrected 

2.2.520 Support: 
- Support for the following models (Compatibility mode) has been added:
GR-C2
MET-C2
MT-C6
Cor-C1.5
GR-C3

Version Program No. Effective Date 

2.2.520 D60210M7_forEDC Initial release 


	RTB 1g: (Discontinued) Firmware Release Note: CAP V2_SP11 for eDC
	RTB 2f: (Discontinued) Firmware Release Note: CAP V2_MP21 for eDC
	RTB 3m: (Discontinued) Firmware Release Note: CAP V2_MP11 for eDC
	RTB 4k: (Discontinued) Firmware Release Note: ELP NX V2_SP11 for eDC
	RTB 5j: (Discontinued) Firmware Release Note: ELP NX V2_MP21 for eDC
	RTB 6n: (Discontinued) Firmware Release Note: ELP NX V2_MP11 for eDC
	RTB 7l: Card Authentication Package v2 Installation Manual
	RTB 8m: Enhanced Locked Print NX v2 Installation Manual
	RTB 9q: Enhanced Locked Print NX v2 with CAP Installation manual
	RTB 10: Installation on 11A Models
	RTB 11e: (Discontinued) Firmware Release Note: CAP V2_MP31 for eDC
	RTB 12f: (Discontinued) Firmware Release Note: ELP NX V2_MP31 for eDC
	RTB 13f: (Discontinued) Firmware Release Note: ELP NX V2_MP12 for eDC
	RTB 14: How to Install ELP-NX v2 on 12A models (MET-C1, CH-C1, OR-C2)
	RTB 15e: Firmware Release Note: CAP User Config for eDC
	RTB 16j: Firmware Release Note: CAP V2_Z11 for eDC
	RTB 17i: Firmware Release Note: ELP NX V2_Z12 for eDC
	RTB 18: Authentication priority mode for Hybrid mode
	RTB 19b: (Discontinued) Firmware Release Note: ELP NX V2_SP12 for eDC
	RTB 20a: (Discontinued) Firmware Release Note: ELP NX V2_MP32 for eDC
	RTB 21f: Firmware Release Note: ELP-NX FS V2 for RA
	RTB 22a: Firmware Release Note: ELP-NX FS V2 for RKR
	RTB 23f: Firmware Release Note: ELP-NX FS V2 for RAC
	RTB 24f: Firmware Release Note: ELP-NX FS V2 for RE
	RTB 25b: Firmware Release Note: CAP NFC Plugin for eDC
	RTB 26: (Discontinued) Firmware Release Note: ELP NX V2_SP13 for eDC
	RTB 27: (Discontinued) Firmware Release Note: ELP NX V2_MP33 for eDC
	RTB 28: Firmware Release Note: ELP NX V2_MP13 for eDC
	AE2 NFC Plugin for eDC
	RD602007l.pdf
	Installation
	Installation
	Installation (Smart Operation Panel/WVGA/4.3-inch operation panel models)
	Installation Flowchart
	Installation Environment Settings
	Installation of VM Card
	JavaVM Configuration
	IC Card Reader/Writer connection
	IC Card Reader/Writer connection (NFC R/W)
	Authentication Management Settings
	Installation of Card Authentication Package v2
	Activation Check
	[Standard Operation Panel model] Priority Feature Setting
	[Smart Operation Panel model] Specific settings
	Icon Setting (Only for 15S or later Smart Operation Panel models):
	Icon Setting (Only for 15S or before Smart Operation Panel models):
	Screen device always-connection Setting (15S or later models)
	Recommendation: Energy Saving Recovery for Business Application setting (15S or later
	Priority Feature Setting (Compatibility mode):
	Authentication priority mode (For Hybrid mode / Full Native mode):


	Installation (4-line MFP/4-line LP/LP)
	Installation Flowchart
	Installation Environment Settings
	VM Card Installation
	IC Card Reader/Writer connection
	Authentication Management Settings
	Card Authentication Package V2 Installation
	Automatic Startup Settings
	Installation Check
	Priority Feature Setting

	Installation (Pre-include model)
	Installation Flowchart
	Installation Environment Settings
	IC Card Reader/Writer Connection (NFC R/W)
	Authentication Management Settings
	Installation of CAP v2
	Activation Check
	[Smart Operation Panel model] Specific settings

	When Migrate to Card Authentication Package v2 from v1
	Conversion Flowchart
	Export the Data
	Uninstall Card Authentication Package v1
	Install Card Authentication Package v2
	Convert the Data Format
	Import the Data



	Uninstallation
	Uninstallation
	Uninstallation (Smart Operation Panel/WVGA/4.3-inch operation panel models)
	[Smart Operation Panel model] Specific settings (Hybrid mode / Full Native mode)
	Setting in the Device
	Priority Feature Cancellation
	Authentication Management Settings
	How to stop applications
	Uninstallation of CAP v2
	SP Mode Cancellation

	Uninstallation (4-line MFP/4-line LP/LP)
	Setting in the Device
	Setting with Web Image Monitor
	SP Mode Cancellation
	Priority Feature Cancellation



	Appendix
	VM Card Update
	Procedure for changing the HDD
	Procedure for changing the controller board
	Procedure for changing the Smart Operation Panel


	RD602008m.pdf
	Installation
	Installation
	Installation (Smart Operation Panel/WVGA/4.3-inch operation panel models)
	Installation Flowchart
	Installation Environment Settings
	VM Card Installation
	JavaVM Configuration
	Installation of Enhanced Locked Print NX V2
	Installation of FR Filter
	Activation Check
	[Standard Operation Panel model] Priority Feature Setting
	[Smart Operation Panel model] specific settings
	Icon Setting (Only for 15S or later Smart Operation Panel models):
	Icon Setting (Only for 15S or before Smart Operation Panel models):
	Screen device always-connection Setting (15S or later models)
	Recommendation: Energy Saving Recovery for Business Application setting (15S or later models)
	Priority Feature Setting (For Compatibility / Hybrid mode / Full Native mode):


	Installation (4-line MFP/4-line LP/LP)
	Installation Flowchart
	Installation Environment Settings
	Installation of VM Card
	Enhanced Locked Print NX V2 Installation
	FR Filter Installation
	Installation Check
	Priority Feature Setting

	Installation (Pre-include model)
	Installation Flowchart
	Installation Environment Settings
	Installation of Enhanced Locked Print NX V2
	Activation Check
	[Smart Operation Panel model] Specific settings



	Uninstallation
	Uninstallation
	Uninstallation (Smart Operation Panel/WVGA/4.3-inch operation panel models)
	Priority Feature Cancellation
	Uninstallation of Enhanced Locked Print NX V2
	Uninstallation of FR Filter
	SP Mode Cancellation (Only Full native mode)

	Uninstallation (4-line MFP/4-line LP/LP)
	Priority Feature Cancellation
	Enhanced Locked Print NX V2 Uninstallation
	FR Filter Uninstallation



	Appendix
	VM Card Update
	Procedure for changing the HDD
	Procedure for changing the controller board
	Procedure for changing the Smart Operation Panel


	RD602009q.pdf
	Installation
	Installation
	Installation (Smart Operation Panel/WVGA/4.3-inch operation panel models)
	Installation Flowchart
	Installation Environment Settings
	Installation of VM Card
	JavaVM Configuration
	IC Card Reader/Writer Connection
	IC Card Reader/Writer Connection (NFC R/W)
	Authentication Management Settings
	Installation of Enhanced Locked Print NX V2 with CAP
	Installation of FR Filter
	Activation Check
	[Standard Operation Panel model] Priority Feature Setting
	[Smart Operation Panel model] Specific settings
	Icon Setting (Only for 15S or later Smart Operation Panel models):
	Icon Setting (Only for 15S or before Smart Operation Panel models):
	Screen device always-connection Setting (15S or later models)
	Recommendation: Energy Saving Recovery for Business Application setting (15S or later models)
	Priority Feature Setting (For Compatibility / Hybrid mode):
	Authentication priority mode (For Hybrid mode / Full Native mode):


	Installation (4-line MFP/4-line LP/LP)
	Installation Flowchart
	Installation Environment Settings
	Installation of VM Card
	IC Card Reader/Writer Connection
	Authentication Management Settings
	Installation of Enhanced Locked Print NX V2 with CAP
	Installation of FR Filter
	Installation Check
	Priority Feature Setting

	Installation (Pre-include model)
	Installation Flowchart
	Installation Environment Settings
	IC Card Reader/Writer Connection (NFC R/W)
	Authentication Management Settings
	Installation of Enhanced Locked Print NX V2 with CAP
	Activation Check
	[Smart Operation Panel model] Specific settings

	When Migrate to Card Authentication Package v2 from v1
	Conversion Flowchart
	Export the Data
	Uninstall Card Authentication Package v1
	Install Card Authentication Package v2
	Convert the Data Format
	Import the Data



	Uninstallation
	Uninstallation
	Uninstallation (Smart Operation Panel/WVGA/4.3-inch operation panel models)
	[Smart Operation Panel model] Specific settings (Hybrid mode / Full Native mode)
	Setting in the Device
	Priority Feature Cancellation
	Authentication Management Settings
	How to stop applications
	Uninstallation of Enhanced Locked Print NX V2 with CAP
	Uninstallation of FR Filter
	SP Mode Cancellation

	Uninstallation (4-line MFP/4-line LP/LP)
	Setting in the Device
	Setting from Web Image Monitor
	SP Mode Cancellation
	Priority Feature Cancellation



	Appendix
	VM Card Update
	Procedure for changing the HDD
	Procedure for changing the controller board
	Procedure for changing the Smart Operation Panel



